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ObservelT Custom Installation

In a custom installation, each of the ObservelT components can be installed separately and you can dis-
tribute the components and use advanced configuration options as needed. This is the most common
type of installation.

Custom Installation is often used in environments with higher security procedures, requiring each com-
ponent of the ObservelT product to be installed separately and using dedicated service accounts; or in
large-scale environments requiring custom modifications of some of the server-side components.

Active Directory Domain membership is not mandatory, although ideally all components should be
placed on domain members. This enables usage of AD groups for Console Users; filtering of AD groups
for Privileged Identity Management; DNS integration for Agent auto-configuration; and GPO-based install-
ation.
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Assumptions

This section describes the assumptions for examples included in the Custom Installation steps.

SYSTEM REQUIREMENT ASSUMPTIONS

The diagram below shows the system requirements for the Custom Installation that is described in this
documentation.
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In the Custom Installation examples in the documentation, the following is assumed.

Server Name Function Software

MSSQL Server 2016 Standard
Database server
SQLSrv Windows Server 2016 Standard
File server
SQL Management Studio 17

ObservelT Application Server Web Console Windows Server 2016
OITsrvl

ObservelT Web Console Standard Microsoft IIS 10
OITAgent ObservelT Agent Windows Server 2016 Standard

The diagram below is an example If you use a more complex installation.
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Server Name Function Software
MSSQL Server 2016 Standard
Database server
SQLSrv Windows Server 2016 Standard
File server
SQL Management Studio 17
Windows Server 2016 Standard
OITsrvl ObservelT Application Server #1
Standard Microsoft I1S 10
Windows Server 2016 Standard
OITsrv2 ObservelT Application Server #2
Standard Microsoft IS 10
Windows Server 2016 Standard
OlTweb ObservelT Web Console
Standard Microsoft I1S 10
FILEsrv File Server Windows Server 2016 Standard
OITAgent ObservelT Agent Windows Server 2016 Standard
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SYSTEM PREREQUISITES ASSUMPTIONS

For the system requirements in a custom installation, the following is required:

e Allcomputers must be members of the same Active Directory domain

® |ogon permissions to the computers must be defined with administrative permissions (local admin-
istrator)

® Permissions to create a service account user in Active Directory

You must prepare the following in a custom installation:

e Permissions to access the SQL Server database engine (SYSADMIN permissions)

* Permissions to grant the service account DBCREATOR permissions on the SQL Server

e Permissions to create folder(s) and share(s) on the server acting as the file server

e Permissions to grant the service account MODIFY permissions on the file share(s)

e Full network connectivity with no firewall restrictions between the components of the deployment,
or permissions to create the appropriate firewall rules to allow the requested traffic type

e Fordataencryption (data in transit, data at rest, Web Console traffic):

* Aninternal Certificate Authority (CA) capable of issuing the correct digital certificates (it is possible
to use self-signed certificates, however that may add complexity to the deployment)

* Fordetailed instructions, hardware recommendations and sizing refer to the ObservelT General
Prerequisites and Recommendations document which can be obtained by contacting ObservelT’s
professional Services team at proserv@observeit.com.

ADDITIONAL ASSUMPTIONS FOR CUSTOM INSTALLATION

The server hosting the ObservelT server-side website application is a member of an Active Directory
domain, but not a domain controller (DC). Hosting IIS on a domain controller may cause adverse security
issues and should be avoided. However, it may be possible when installing in an isolated lab envir-
onment. When installing on a DC, you need to use the “Active Directory Users and Computers” MMC
snap-in and add the ObservelT service account to the “Administrators” group found in the “Builtin” con-
tainer, but this will affect all the DCs in the domain.

The reader has prior knowledge of Public Key Infrastructure (PKI) and its related terminology.

Your organization has an SQL server administrator who follows best practices for deploying and main-
taining SQL server.

Your organization has a backup administrator, who follows best practices for backing up databases, Oper-
ating Systems, and file shares.
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Downloading the Latest Version

When you're ready to install or update to a new version, you can download the files you need. Files are
located in the Downloads page of the ObservelT Support Portal.

You need a username and password.

1. Download the files you need from here.

2. Login and from the Downloads page, click the Link you want.

Doenloads

bt
degpont
b
b [
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-

3. Savethefileto C:\Temp on the ObservelT Application server.
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4. Extract the content of the ZIP file.

The following folders and files are included:

e DB: Contains the setup files for the 4 ObservelT SQL databases

e DB _Analytics: Contains the setup files for the ObservelT analytics database

e Insider Threat Library: Contains the exported rule library for duplication and review

e Mac Agent: Contains the Mac agent install binaries

e ScreenshotsStorageOptimizer: Optimizes screenshot storage for efficiency

e SQLEXPR x64 ENU: Installation package for SQLExpress for the purpose of the trial (you can use
your own instance of SQL in lieu of SQL Express if you prefer)

® TrialAssistant: Install cleanup scripts

e Typical Install: ObservelT One-Click installation scripts and data

e Unix-Linux Agent: Various unix/linux agent install packages

e Utilities: Several useful tools such as the ObservelT field-marking utility and Statistics collector

e Web: Contains the Web console and application server packages

e WebsiteCat: Contains the new ObservelT web categorization module


https://observeit.force.com/support/s/product-downloads
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e Winagent64bit: Contains the ObservelT windows agent for 64 bit systems

e OIT Quick Start Guide: Contains system minimum requirements and helpful notes for the latest ver-
sion

e Typicallnstall folder: Contains ObservelT.Installer.exe, a self-contained one-click ObservelT installer

* WinAgentUpdater32bit: Contains the Updater It.Updater(x86).msi installer for Windows 32 bit. You
must install the Updated the first time you use it.

e  WinAgentUpdater64bit: Contains the Updater It.Updater(x64).msi installer for Windows 64 bit. You
must install the Updated the first time you use it.

10
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Custom Installation Steps

Follow these steps to complete the installation process.

Before you begin, make sure you have completed Prerequisites for Custom Installation.

1. Preparing the Environment

1.
2.
3.
4.

Formatting a Disk for Graphic Images Storage and the Database
Creating and Sharing the Graphics Image Folders

Installing Prerequisites for a Custom Installation

Configuring Windows Firewall

2. Preparing Permissions

1.
2.
3.
4.

Creating a Service Account User in Active Directory

Assigning SQL Permissions to the Service Account User

Adding the Service Account User to the Local Administrators Group
Adding the Service Account User to the Local IIS_IUSRS Group

3. Installing and Configuring Databases

1.

vk WS

6.

Configuring Location for Recorded Screenshots
Installing the ObservelT Databases

Verifying Database Installation

Moving Database File to Drives

Setting Initial Database File Sizes

Installing Database Maintenance

4. Configuring Microsoft Internet Information Server (lIS)

Obtaining a Digital Certificate

Assigning a Digital Certificate

Creating a New Application Poolin IS 8.X

Creating a New Website in IS 8.X for the Application Server
Creating a New Website in IIS 8.X for the Web Console

5. Installing ObservelT Components

1.

us WS

6.

Installing ObservelT Application Server
Installing ObservelT Web Management Console
Obtaining a Commercial License

Installing the Screenshots Storage Optimizer
Installing the Website Categorization Module
Verifying the ObservelT Services ldentity

6. Configuring ObservelT Installation

1.
2.

Configuring the Admin Password
Configuring LDAP Settings

11
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3. Configuring SMTP Settings

4. Configuring Screen Capture Data Storage
7. Configuring Traffic Security

1. Configuring ObservelT Application Server for Data Transit Encryption

2. Configuring Windows Agents to Use SSL

3. Configuring a Mac Agent to use SSL

4. Configuring a Unix Linux Agent to Use SSL

5. Configuring Screen Capture Data Storage
8. Installing ObservelT Agents

1. Windows Agent Deployment

2. macOS Agent Deployment

3. Unix/Linux Deployment

12
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Preparing the Environment

Custom Installation is often used in environments with higher security procedures, requiring each com-
ponent of the ObservelT product to be installed separately and using dedicated service accounts; or in
large-scale environments requiring custom modifications of some of the server-side components.

The diagram below shows an example of a file server. This is where the configuration starts.

File Server

The following tasks describes how to prepare your Windows Server machines for ObservelT installation.

e Formatting a Disk for Graphic Images Storage and the Database
e (Creating and Sharing the Graphics Image Folders

e |Installing Prerequisites

® Configuring Windows Firewall

FORMATTING A DISK FOR GRAPHIC IMAGES STORAGE AND THE DATABASE

Screen capture data is configured separately.

As a matter of best practice, for medium to large scale deployments, ObservelT recorded images are
stored on a file share server in the network. Configuring all recorded graphic screenshots to be stored in
the file system network share (a UNC path) instead of in the SQL database reduces the overall I/O over-
head on the SQL Server.

This section describes how to configure the disks before creating the file share.
Forinformation about creating the file share, see Creating and Sharing the Graphics Image Folders.
By default, all the recorded graphic screenshots are stored in the ObservelT_Data database.

If using a file share, it is highly recommended to use a Windows Server 2016 machine with appropriate
disk capacity, where the disk drive(s) are connected either locally, or on a storage device such as SAN/NAS
using either iSCSI or Fiber Channel (FC). Where this is not possible, use virtual disks that are stored on the
fastest and most optimized storage array for write IOPS.

Storage Types

There are a total of 3 types of storage you can use for recording screenshot data:

13
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Hot storage: Recording screenshot data is written immediately after being received from a remote
ObservelT Agent. Because all the graphic images stored on the hot storage are typically small, the
disk needs to be formatted with NTFS file system for Windows Server 2016 using the allocation unit
size of 4KB (4096K). This ensures best disk location usage and reduce disk space waste.

Warm storage: Recording screenshot data is stored after an active ObservelT session is closed. The
recording screenshot data stored on the warm and archive storage is stored in a ZIP format, with
each ZIP file containing all images for a single ObservelT session. To optimize performance, format
the warm and archive storage with 64KB block size. This configuration can be done using Disk Man-
agement or the DISKPART command line utility.

Archive storage: Recording screenshot data is moved during an archive operation.

Do not enable disk compression.

Format the Disk Using Computer Management

This example assumes the file share is to be located on a Windows Server 2016 Operating System and
describes the procedure to configure the disks (and later —the file share) on this Operating System.

In this example, assume the new disk has just been connected to the machine, but no further
action was taken.

1.

2.

Connect to the computer acting as the ObservelT file share.

From Start, type Computer Management.

The Computer Management window opens.

Expand Computer Management (Local), expand Storage, and click Disk Management.
The list of disks appears.

Find the new diskin the list. Usually, it is the only one with the status Offline.

14
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5. Right-click the disk and select Online.
6. Right-clickthe disk again and select Initialize Disk.
7. Click the GPT (GUID Partition Table) radio button and click OK.

8. Right-clickthe partition and select New Simple Volume.

= Disk 1

Basic
1497 GB 1497 GB
Online Unallocated

Mew Simple Vhame_.

"0 Disk 2 I

[
Basic
15,00 GB 15,00 GB
Offline () Unallocsted

9. The Wizard opens, click Next.
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Specify Volume Size

Choose a volume size that is between the maximum and minimum sizes.

Maxdmum disk space in MB: 15326

Minimum digk space in MB: 8

Simple volume size in MB: 15326 =

< Back Next > Cancel

10. Make sure maximum the values specified in the Maximum disk space in MB and Simple volume size
in MB are equal. Click Next.

New Simple Volume Wizard X

Assign Drive Letter or Path
For easier access, you can assign a dive |etter or drive path to your partition.

(@) Assian the following drive letter: D ~
() Mount in the following empty NTFS folder:
Browse...
() Do not assian a drive letter or drive path
< Back MNext = Cancel

11. Assign an appropriate drive letter. Click Next.

16
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12. Click the Format this volume with the following settings radio button and select NTFS.
13. Set the Allocation unit size:

e 4096 for the hot storage.
* 64KB for the warm and archive storage.
e 64KB for SQL database.
14. Assign an appropriate volume label at the Volume label field.

15. Make sure Perform a quick format checkbox is checked.
16. Click Next and review the settings. Click Finish.

17. Thediskis formatted and you are returned to the Computer Management window.

Validating Compression and Indexing Settings

1. From the Computer Management window, expand the Computer Management (Local) node,
expand the Storage node, and click the Disk Management node.

2. Inthe main window, locate the volume designated for the ObservelT screenshot data.
3. Right-click the volume and choose Properties from the menu.

4. Make sure the Allow files on this drive to have contents indexed in addition to file properties check
box is unchecked.

17
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5. Click OK.

CREATING AND SHARING THE GRAPHICS IMAGE FOLDERS

This topic describes how to create a file share so you can share folders on a Windows Server file server.

If you want to use Network Access Storage (NAS) or a different storage type, see your storage
vendor documentation.

1. Connect to the computer acting as the ObservelT file share.
2. Open Windows File Explorer. (You can open the Start menu and type in explorer, then Enter.)

3. In Windows File Explorer, navigate to a disk where the ObservelT image store folder is to be loc-
ated.

4. Create a new folder. (Click New and then Folder) and right-click some empty space inside the File
Explorer window).

5. Give thefolder an appropriate name, for example: OITHotStorage.
6. Right-clickthe folder, click Share With, and click Specific people.
7. Typein the account name, for example OITServiceAccount and click Add.

The new account is added.

8. Select the account and set the Permission Level. Choose Read/Write. Click Share.

18



observeir

a division of Proofpoint

Name
A administratar
2 Administrators

B SUPPAOIT Servicefccount
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Cancel
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OiMHetStorage
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fou can £-rrall semesne links to these shared items, or copy and paste the links into ancther pragram,

-

10. Create folders for the ObservelT Archive folder, for example: OITWarmStorage and OITArchive by
repeating the previous steps.

Make a note to remember the paths to the current shares. You'll need them later.

For example:

\\filesrv\OITData\OITHotStorage

\\filesrv\OITData\OITWarmStorage

\\filesrv\OITData\OITArchive

INSTALLING PREREQUISITES FOR A CUSTOM INSTALLATION

ObservelT Application Server and ObservelT Web Console require several prerequisites, such as Microsoft
Internet Information Services and the .Net Framework. You can install these automatically using Power-

Shell.
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Mount a Windows Server 2016 installation DVD to the virtual machine or insert a Windows Server
2016 DVD into the DVD drive of the server.

In this example, Windows Server 2016. You can install with Windows Server 2019.

The following steps are similar for Windows Server 2012/2012R2 Operating Systems. If using
one of these systems, mount or insert the appropriate DVD to the machine.

Open the Start menu and type in PowerShell.
Right-click the PowerShell shortcut and choose Run as administrator.
If prompted, Do you want to allow this app to make changes to your device? Click Yes.

Copy and paste the following command:

Install-WindowsFeature Web-Server, Web-WebServer, Web-Common-
Http, Web-Default-Doc, Web-Dir-Browsing, Web-Http-Errors, Web-
Static-Content, Web-Health, Web-Http-Logging, Web-Performance,
Web-Stat-Compression, Web-Security, Web-Filtering, Web-App-Dev,
Web-Net-Ext45, Web-Asp, Web-Asp-Netd45, Web-ISAPI-Ext, Web-ISAPI-
Filter, Web-Mgmt-Tools, Web-Mgmt-Console, NET-WCF-Services45,
NET-WCF-HTTP-Activation45, NET-Framework-45-Core, NET-Framework-
45-Features, NET-Framework-45-ASPNET

CONFIGURING WINDOWS FIREWALL

When

Windows Firewall is enabled, you need to configure the Windows Firewall on the SQL server and

the ObservelT Application server.

Configuring Windows Firewall on SQL server

In this

1.

2.

3.

example, it is assumed that all default ports are used.

From the Windows Run window, open PowerShell.

Make sure you are running PowerShell as an administrator.
If porompted Do you want to allow this app to make changes to your device?, click Yes.

Copy and paste the following code into the PowerShell window:

20
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4,

New-NetFirewallRule -DisplayName “SQL Server” -Direction Inbound
—-Protocol TCP -LocalPort 1433 -Action allow

New-NetFirewallRule -DisplayName “SQL Admin Connection” -
Direction Inbound -Protocol TCP -LocalPort 1434 -Action allow

New-NetFirewallRule -DisplayName “SQL Database Management” -
Direction Inbound -Protocol UDP -LocalPort 1434 -Action allow

New-NetFirewallRule -DisplayName “SQL Debugger/RPC” -Direction
Inbound -Protocol TCP -LocalPort 135 -Action allow

Close the PowerShell window.

Configuring Windows Firewall on ObservelT Application Server

In this

1.

4.

example, it is assumed that all default ports are used.

From the Windows Run window open PowerShell.

Make sure you are running PowerShell as an administrator.

If porompted Do you want to allow this app to make changes to your device?, click Yes.

Copy and paste the following code into the PowerShell window:

New-NetFirewallRule -DisplayName “HTTPS” -Direction Inbound -
Protocol TCP -LocalPort 443 -Action allow

Close the PowerShell window.

Preparing Permissions

In a custom installation, make sure the following permissions are configured:

Permissions to create a service account user in Active Directory

Permissions to grant the service account DBCREATOR permissions on the SQL Server
Permissions to access the SQL Server database engine (SYSADMIN permissions)

Logon permissions to computers, with administrative permissions (local administrator)

21
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CREATING A SERVICE ACCOUNT USER IN ACTIVE DIRECTORY

This topic describes how to configure permissions to create a service account user in Active Directory. Act-
ive Directory is used connect to ObservelT databases and to run ObservelT services.

Permissions are required to set up a an Active Directory. For more information about this, contact
the Active Directory team.

1. Connect to a Domain Controller or to a computer with Active Directory Remote Server Admin-
istration Tools installed.

2. Click Start and type dsa .msc and Enter.
3. Navigate to the Organizational Unit where the ObservelT Service Account will be located.

4. Right-click the Organizational Unit, selectNew > User.

Optional: Type ObservelT into the First Name field and Service Account into the Last Name field.

5. Type OITServiceAccount into the User logon name field and choose the appropriate UPN suffix.
Click Next.

6. Configure a password based on your organization's password policy requirements, uncheck the
User must change password at next logon checkbox, and check the Password never expires check-
box. Click Next. Click Finish.

7. Close the Active Directory Users and Computers window.

ASSIGNING SQL PERMISSIONS TO THE SERVICE ACCOUNT USER

This procedure describes how to configure permissions to access the SQL Server database engine
(SYSADMIN permissions) and grant the ObservelT Server Account user the dbcreater role on the
SQL server.

Use the following steps to grant the ObservelT Service Account user the dbcreator role on the SQL
server. This permission is required only during the installation phase and may be removed when
the installation is complete. Removing this permission will prevent ObservelT from creating addi-
tional archive databases with the service account and will require appropriate credentials when
creating a new archive.

1. Connect to the SQL server or to a computer with SQL Server Management Studio installed.

2. Open SQL Server Management Studio, type the SQL server's FQDN or IP address in the Server
name field and click Connect.

22
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3. Select the authentication.
Choose Windows Authentication if your account has sysadmin permissions on the SQL server.

Otherwise, choose SQL Server Authentication and log in with a sysadmin-level account. Click OK to
connect.

4. From the menu on the left, expand Security right-click Logins and select New Login.

The Login screen opens.

d Legin - New - o -

Salect a page
4 Garwral
% Server Foles
A Coas (%) Windwrs puthentication
o ) 50U Server suthertication

L Seipt = [ Heip

) Mapped o cerficate

Connecton () Mapped 1o agymmetnc key
Server Cregential
SUPTWZ01E L Mapta
Mapped Cradentials Cradertin

Cormection
SUPTW2016 Administrator
By Vew connection propeey

Diefoult language: cdefot> -

5. Click Search.

23
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Select User or Growp >
Salect this object hype

|1.|uru Busht-n socusty prncpal Object Types_.
From this location:

Erter tha cbpect name Lo selact (Eamples):

Chesci: Mames

6. Click Locations and choose the location where the ObservelT Service Account is located. Click OK.

7. In Enter the object name to select area, type the username for the ObservelT Service Account user
account, for example, OITServiceAccount. Click OK.

8. Inthe Login screen from the menu on the left, select Select a Page > Server Roles.

O vLegin- Mew - a * |
Selecta page i - It '
0 Fsow - [YH
& Sarver Folss
A Lsar Mapping Sarver role iy usad 1o grant serverside securty privieges 10 & user.
E‘Sem.uﬁs
¥ Qahas
Server mles:
] bubcadmin

i

Conneclon

Sanver

SUPW2e

Conrsction:

SUPTW2015 Administrator

27 View connection properties
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9. Select dbcreator and click OK.

10. Close the SQL Management Server Studio.

ADDING THE SERVICE ACCOUNT USER TO THE LOCAL ADMINISTRATORS
GROUP

This topic describes how to addd the ObservelT service account user to the local Administrators group on
the ObservelT Application Server(s) (and Web Console machine if installed on a separate computer).

This is only required during the installation phase; the Service Account can be removed as soon as
the installation has completed successfully.

1. Onthe ObservelT Application Server, from Start, type Computer Management.
The Computer Management window opens.

2. Expand System Tools and click Local Users and Groups. Expand Groups folder.

A Computer Management
ile  Action View Help
= HE dE]

;g Computer Management (Local]| MName Description Actions

v ik %ﬁ:m;soor:sd | | Access Control Assist.. Members of this group can remot.. Groups -~
@ Eas t:’ eduler 2l Administrators Administrators have complete an.. More Actions 4
VENE Viewer i Backup Operators Backup Operators can override se..

x Shared Folders et . .
il Certificate Service DC..  Members of this group are allowe...

v Local Users and Groups|| .=
® F i Cryptographic Operat.. Members are authorized to perfor...

: g:::ps %:Diﬁributed COM Users  Members are allowed to launch, a..

@ Performance % Event Log Readers Members of this group can read ...

:.l. Device Manager %ﬁuests Guests have the same access as m...
{3 Storage % Hyper-V Administrators  Members of this group have com...
{@ Windows Server Backug $:IIS_IUSRS Built-in group used by Internet Inf...

&7 Disk Management i Network Configuratio... Mermbers in this group can have s..

i; Services and Applications || &% Performance Log Users  Members of this group may sche...

& Performance Monitor .. Members of this group can acces...

a%: Power Users Power Users are included for back...
$: Print Operators Members can administer printers ...
$: RDS Endpeint Servers  Servers in this group run virtual m...
&E: RDS Management Ser... Servers in this group can perform ...
&E: RDS Remote Access 5. Servers in this group enable users ...
%I Remote Desktop Users  Members in this group are grante...
%: Remote Management... Members of this group can acces...
%: Replicator Supports file replication in a dom...
%: Storage Replica Admi... Members of this group have com...
%: Systermn Managed Acc... Members of this group are mana...

e Users Users are prevented from making ..
8 SOLServer200550LBro... Members in the group have the re...

3. From the list of Groups, double-click Administrators group.

The Administrator Properties dialog box opens.
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l}dmmmmms Properties

R
3

[ —
82, SUPP\Domain Admens

(Changes 1o a user's group

mambersh
Add... e ot afctive unti the nedt time the
user logs on
Cance e
4. Click Add.

The Select Users, Computers, Service Accounts, or Groups dialog box opens

5. In the Enter the object name to select area, for example, OITServiceAccount
\?elect Users, Computers, Service Accounts, or Groups x
Select this object type:
|Users. Service Accounts, or Groups | Chbject Types...
From this location:
|5UPP-|—OC-"\|— | Locations...
Enter the object names to select (sxamples):
0ITServiceAccourt| Check MNames
Advanced... Cancel
6. Click OK.

list.

The Administrator Properties dialog box opens and OITServiceAccount appears in the Members
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Administrators Properties ? *
General
"
Descrtion: | Administratirs have complete snd unrestncted sccess
8o the computer/domain
Menbers
& raminstrator
B2, SUPP\Domain Admins
& suerorT oI +@SUPP LOCAL)
Changes 1o & user's group membersho
Add_ Remave a rot effectsve until the neot time the

e ke en.

[Cox ][ conce Fooly Help

7. Click OK.

8. Ifyou plan to deploy more than one ObservelT Application Server, or if you plan to install the
ObservelT Web Console on a separate machine, repeat on all the computers that will host the
ObservelT Application and Web Console applications.

ADDING THE SERVICE ACCOUNT USER TO THE LOCAL IIS_IUSRS GROUP

This topic describes how to add the ObservelT service account user to the local IIS_[USRS group on the
ObservelT Application Server(s) (and the Web Console machine if installed on a separate computer).

This step is only required during the installation phase; the Service Account can be removed as
soon as the installation has completed successfully.

1. Onthe ObservelT Application Server, from Start, type Computer Management.

The Computer Management window opens.

2. Expand System Tools and click Local Users and Groups. Expand Groups folder.
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& Computer Management

ile  Action View Help

o= | HE d=|HE

A Computer Management (Local
~ [[’L!; System Tools
@ Task Scheduler
2] Event Viewer
i Shared Folders
~ @& Local Users and Groups
| Users
| Groups
@ Perfermance
% Device Manager
v {25 Storage
{)ﬁ) Windows Server Backug
&7 Disk Management
:3:«; Services and Applications

3. From the list of Groups, double-click IS_IUSRS group.

Name

%:Access Control Assist...
%:Administratnrs

% Backup Operators

| Certificate Service DC...
%:Cryptographic Operat...
O/ Distributed COM Users
&g: Event Log Readers
&E:Guests

%I Hyper-V Administrators
e 1is_IUSRS

%:Network Configuratio...
%:Parformance Log Users
%:Perfnrman(e Monitor ...
%:iner Users

i Print Operators
RDS Endpoint Servers
%: RDS Management Ser...
%: RDS Remote Access 5.,
$: Remote Desktop Users
&g: Remote Management...
&E: Replicator

%I Storage Replica Admi...
%.System Managed Acc...
%:Users

3 501 Server200550L Bro...

Description

Members of this group can remot...
Administrators have complete an...
Backup Operators can override se...
Members of this group are allowe...
Members are authorized to perfor...
Members are allowed to launch, a...
Members of this group can read e..
Guests have the same access as m..,
Members of this group have com...
Built-in group used by Internet Inf...
Members in this group can haves.
Members of this group may sche...

Members of this group can acces..
Power Users are included for back...
Members can adrinister printers ...
Servers in this group run virtual m..
Servers in this group can perform .
Servers in this group enable users ...
Members in this group are grante...
Members of this group can acces..
Supports file replication in a dom...
Members of this group have com...
Members of this group are mana...

Users are prevented from making ...
Members in the group have the re...

The Administrator Properties dialog box opens.

hdmlnl:!ralnr: Properties

? x
General
& Admiristraion
o
Description: and access |
e the computer/domain
Members
& fdmeestrator

52, SUPP\Domain Admang

Changes 1o 8 user's Jroup

st logs o6,

o] e

4. Click Add.

The Select Users, Computers, Service Accounts, or Groups dialog box opens.

5. Inthe Enter the object name to select area, type OITServiceAccount.

are inot effactive until the et time the

Aoy Help

Actions
Groups

Mare Actions



observeir

a division of Proofpoint

?elect Users, Computers, Service Accounts, or Groups

Select this object type:

|Users.Senr1ce Accounts, or Groups | | Cbject Types... |

From this location:
|su PP LOCAL

| | Locations... |
Enter the object names to select (sxamples):
0ITService Accourt| Check Names
F ] s

6. Click OK.

The IRS_IUSRS Properties dialog box opens and OITServiceAccount appears in the Members list.

1I5_IUSRS Properies i =
General
% 5_IUSRS
Cheerigtair Bt in group wsad by Intemat Information Senvices.
Mambars

. & SUPPDIT SenviceAccount IDITSenviceAccount @5UPP LOCAL)

Changes (o & user's group =

m.
Femove a0 ik oflctie LAl the et tme the

iy g on.

O Canesl L Haigy

7. Click OK.
8. Ifyou plan to deploy more than one ObservelT Application Server, or if you plan to install the

ObservelT Web Console on a separate machine, repeat on all the computers that will host the
ObservelT Application and Web Console applications.

Installing and Configuring Databases

When performing a custom installation, the database is the first component of ObservelT that needs to
be installed.

To successfully in install the database you need to:
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e Choosethe location of the recorded graphic screenshots storage: By default, all the recorded
graphic screenshots are stored in the ObservelT_Data database. In medium to large deployments
of ObservelT, it is strongly recommended to configure all recorded graphic screenshots to be
stored in the file system network share (a UNC path) instead of in the SQL database. This will
reduce the overall I/O overhead on the SQL Server. (For information about formatting the volumes.

e Install the ObservelT databases: By default, ObservelT uses Microsoft SQL Server databases for
data storage. This storage includes user activity configuration data, user analytics data, textual
audit metadata and possibly the screenshots captured by the ObservelT Agents for video replay.

¢ |nstallthe ObservelT Analytics database.
e Add the ObservelT Application Server(s) machine account to the ObservelT databases.
Choose the location of the recorded graphic screenshots storage.

2. Edit the database installer configuration file to use file system storage for recorded graphic
screenshots.

3. Install the ObservelT databases.

4. Install the ObservelT Analytics database.

5. Add the ObservelT Application Server(s) machine account to the ObservelT databases.
You need to do complete the following tasks:

e Install the ObservelT Databases
e Verify Database Installation

e Move Database File to Drives

e Set MDF and LDF File Size

e |Install Database Maintenance

CONFIGURING LOCATION FOR RECORDED SCREENSHOTS

By default, all the recorded graphic screenshots are stored in the "ObservelT_Data" database on the
SQL Server.

In medium to large deployments of ObservelT, it is recommended to configure all recorded graphic
screenshots to be stored in the file system network share (a UNC path) instead of in the SQL database.
This reduces the overall I/O overhead on the SQL Server.

Afunctional SQL Server database is still required for storing all the recorded metadata, image
pointers, and configuration settings.
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INSTALLING THE OBSERVEIT DATABASES

This topic describes how to attach the databases to the SQL server machine.

The DB install process can also be run directly on the SQL Server machine.

The time displayed in the Web Console is defined by the time zone of the database. Therefore, it is
recommended that both the Web Console and Database are installed with the same time zone.

The diagram below shows the file server and the SQL database. The SQL database is installed after you
configure the file server.

File Server

SQLsw

Prerequisites

e Thedatabaseinstaller requires .NET Framework 4.5
e SeeInstalling Prerequisites for more information.

Installing the Databases
1. Connect to the computer where you downloaded and extracted the ObservelT Setup files.

2. Run the SQLPackage.exe file located in the DB folder which was created when you extracted the
setup files from the archive.

The Database Installer main window appears.

31



observeir

a division of Proofpoint

3.

This execstable wil create a new database. Please
chates the server nd datshase yiou would B o creste.

More Info...

Select Database

Select the SQL Server on which to install the database. The details of the Server field are in the fol-
lowing format:

<ServerFQDN>\<InstanceName>, <Port>

For example:

SQLsrv.test.lab\ObservelIT, 1433

If the account you are currently using is an SQL Server administrator, select Windows Authentic-
ation as the authentication method. Otherwise, select SQL Server Authentication and provide a
user name and password with privileges to create databases and user accounts. If you select Win-
dows Authentication, you will need to perform additional tasks.

Click Run to begin the installation.

If the connection is successful, the installation will proceed. If not, check the connectivity to the
SQL server and make sure the connection string is correct.

Hint: Check the Windows Firewall on the SQL Server and either turn it off, or add the relevant rules
to allow SQL Server connectivity (TCP port 1433), check protocol bindings (TCP/IP must be
enabled), and check the SQL Server listening port.

Click OK to ignore the following message:

Warning — Unable to create ObservelTUser (Observel TUser Name: ObservelTUser)! (User does not
have permission to perform this action.) Press OK if you wish to continue anyway.

If you did not receive this error, it means that the ObservelT service account has SYSADMIN
permissions on the SQL Server. It is strongly suggested that you stop the installation at this
phase, delete the resulting databases, change the ObservelT service account permissions
to DBCREATOR, and then re-execute the database installer program. While, by itself, this is
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7.

Install
1.

2.

not a problem, the result is that the ObservelT database and the subsequent connection
strings used by all the ObservelT components will use the “ObservelTUser” account in SQL
Server instead of the ObservelT service account. To fix this issue you will need to manually
change the connection strings and change the SQL Server database settings. Contact sup-
port for information on how to perform these changes.

The message .ObservelT database successfully installed appears.

Acknowledge the message the message ObservelT database successfully installed. When the 4
databases are created, the window closes.

ing the Analytics Database
Connect to the computer where you downloaded and extracted the ObservelT Setup files.

Run the SQLPackage.exe file located in the DB_Analytics folder which was created when you extrac-
ted the setup files from the archive.

Select the SQL Server on which to install the database. The details of the Server field are in the fol-
lowing format:

<ServerFQDN>\<InstanceName>, <Port>
For example:

SQLsrv.test.lab\ObservelIT, 1433

If the account you are currently using is an SQL Server administrator, select Windows Authentic-
ation as the authentication method. Otherwise, select SQL Server Authentication and provide a
user name and password with privileges to create databases and user accounts. If you select Win-
dows Authentication, you will need to perform additional tasks.

From File Explorer, navigate and open the DB_Analytics folder and double-click the SQLPackage file.

Click Run.

If the connection is successful, the installation will proceed. If not, check the connectivity to the
SQL server and make sure the connection string is correct.

Hint: Check the Windows Firewall on the SQL Server and either turn it off, or add the relevant rules
to allow SQL Server connectivity (TCP port 1433), check protocol bindings (TCP/IP must be
enabled), and check the SQL Server listening port.

Click OK to ignore the following message.
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Warning —Unable to create ObservelTUser (ObservelTUser Name: ObservelTUser)! (User does not
have permission to perform this action.) Press OK if you wish to continue anyway.

If you did not receive this error, it means that the ObservelT service account has SYSADMIN
permissions on the SQL Server. It is strongly suggested that you stop the installation at this
phase, delete the resulting databases, change the ObservelT service account permissions
to DBCREATOR, and then re-execute the database installer program. While, by itself, this is
not a problem, the result is that the ObservelT database and the subsequent connection
strings used by all the ObservelT components will use the “ObservelTUser” account in SQL
Server instead of the ObservelT service account. To fix this issue you will need to manually
change the connection strings and change the SQL Server database settings. Contact sup-
port for information on how to perform these changes.

The message .ObservelT database successfully installed appears.

8. Acknowledge the success message ObservelT database successfully installed.

VERIFYING DATABASE INSTALLATION

This topic describes how to verify that the databases were successfully installed on the SQL server.
1. Connect to the SQL server or to a computer with SQL Management Studio installed.

2. Open Microsoft SQL Server Management Studio.

The Connect to server window opens.

I3
@ Connect to Server b4

SQL Server

Server type Diatabase Engine w
Searvs name

3. Typeinthe SQL server's FQDN or IP address into the Server name field.

4. Select Windows Authentication if your account has sysadmin permissions on the SQL server.
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Otherwise, choose SQL Server Authentication and log in with a sysadmin-level account.
5. Click Connect.

6. Inthe Microsoft SQL Server Management Studio, Expand Databases. You should see five new
ObservelT databases.

7. Expand Security > Logins.

8. Right-click the ObservelT Service Account user —in this example, OITServiceAccount —and select
Properties.

9. Select User Mapping from Select a Page menu.

Select a page st ~ [ Hep

Emmmmmummi
=

10. Under User mapped to this login click the ObservelT database.
11. Make sure the checkbox in the Map column is checked.

12. Make sure that the checkbox for db_owner is checked.

13. Repeat for all databases.

14. Click OKand close SQL Management Studio.

MOVING DATABASE FILE TO DRIVES

The best practice for SQL databases is to place the database data files (.mdf) and the database log files
(.1df) on separate drives.

This topic describes how to move the ObservelT database files to designated drives.

The following steps assume two designated drives are present at the SQL machine. In the
example, the database drive is assigned the drive letter E:, while the log drive is assigned the drive
letter F:.
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1. Connect to the SQL server or to a computer with SQL Server Management Studio installed.

2. Open Microsoft SQL Server Management Studio.
The Connect to server window opens.

3
@< Connect to Server *

SQL Server

Server type Diatabase Engine w
Served name:

3. Typeinthe SQL server's FQDN or IP address into the Server name field.

4. Select Windows Authentication if your account has sysadmin permissions on the SQL server.
Otherwise, choose SQL Server Authentication and log in with a sysadmin-level account.

5. Click Connect.
6. Pastethe following code into the New Query window:

This action will stop all ObservelT databases and will cause downtime for all ObservelT services.

USE MASTER;

GO

ALTER DATABASE ObservelIT Data

SET SINGLE USER

WITH ROLLBACK IMMEDIATE;
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GO

EXEC MASTER.dbo.sp_detach _db @dbname = N'ObservelIT Data'

GO

USE MASTER;

GO

ALTER DATABASE ObservelT

SET SINGLE_ USER

WITH ROLLBACK IMMEDIATE;

GO

EXEC MASTER.dbo.sp detach db @dbname = N'ObserveIT'

GO

USE MASTER;

GO

ALTER DATABASE ObserveIT Archive 1

SET SINGLE_ USER

WITH ROLLBACK IMMEDIATE;
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GO

EXEC MASTER.dbo.sp detach_db @dbname = N'ObservelIT Archive 1'

GO

USE MASTER;

GO

ALTER DATABASE ObserveIT Archive Template

SET SINGLE_ USER

WITH ROLLBACK IMMEDIATE;

GO

EXEC MASTER.dbo.sp _detach _db @dbname = N'ObservelIT Archive_
Template'

GO

USE MASTER;

GO

ALTER DATABASE ObserveIT Analytics

SET SINGLE USER

WITH ROLLBACK IMMEDIATE;
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10.
11.
12.
13.

14.

15.

16.

GO

EXEC MASTER.dbo.sp detach_db @dbname = N'ObservelIT Analytics'

GO

Click Execute. Wait for the query to finish.

Format 2 new disks in the machine. See "Formatting a Disk for Graphic Images Storage and the
Database" on page 13

In the example below: disk E: for the database data files and disk F: for the database log
files.

From File Explorer, navigate to disk E:.

Create a new folder, MSSQLDATA.

Navigate to disk F:.

Create a new folder, MSSQLLog.

Open PowerShell and run as an administrator.

If porompted Do you want to allow this app to make changes to your device? click Yes.

Paste the following code into the PowerShell window:

Get-ChildItem 'C:\Program Files\Microsoft SQL
Server\MSSQL13.MSSQLSERVER\MSSQL\DATA\' | Where-Object {$_.Name
-like "*observeit*" -and $_.Name -like "*mdf"} | Move-Item -
Destination E:\MSSQLDATA\

Get-ChildItem 'C:\Program Files\Microsoft SQL
Server\MSSQL13.MSSQLSERVER\MSSQL\DATA\' | Where-Object {$_.Name
-like "*observeit*" -and $_.Name -like "*1df"} | Move-Item -
Destination F:\MSSQLLog\

Enter key at the final prompt.

Return to the SQL Server Management Studio.
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17. Click New Query.

18. Paste the following code into the New Query window:

CREATE DATABASE [[observeIT Archivel] ON

( FILENAME

N'E:\MSSQLDATA\ObserveIT Data Data.mdf' ),

( FILENAME = N'F:\MSSQLLog\ObserveIT Data Log.ldf' )

FOR ATTACH

GO

CREATE DATABASE [ObserveIT] ON

( FILENAME = N'E:\MSSQLDATA\ObserveIT Data.mdf' ),
( FILENAME = N'F:\MSSQLLog\ObserveIT Log.ldf' )
FOR ATTACH

GO

CREATE DATABASE [ObserveIT Analytics] ON

( FILENAME = N'E:\MSSQLDATA\ObserveIT Analytics Data.mdf' ),
( FILENAME = N'F:\MSSQLLog\ObserveIT Analytics Log.ldf' )
FOR ATTACH

GO
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CREATE DATABASE [ObservelIT Analytics] ON

( FILENAME = N'E:\MSSQLDATA\ObserveIT Archive 1 Data.mdf' ),
( FILENAME = N'F:\MSSQLLog\ObserveIT Archive 1 Log.ldf' )
FOR ATTACH

GO

CREATE DATABASE [ObservelIT Archive Template] ON

( FILENAME = N'E:\MSSQLDATA\ObserveIT_Archive_Template_Data.mdf'
),

( FILENAME = N'F:\MSSQLLog\ObserveIT Archive Template Log.ldf' )
FOR ATTACH

GO

19. Click Execute. Wait for the query to finish.

20. Close the SQL Server Management Studio.

INSTALLING DATABASE MAINTENANCE

The ObservelT databases have to be maintained on a regular basis in order for the system to work prop-
erly and efficient.

To ensure optimal database health and performance, add the automated maintenance procedure for
your ObservelT databases.

1. Connect to the machine containing the ObservelT database or the machine where SQL Server Man-
agement Studio is installed.

2. Download the file: http://files.observeit.com/support/OIT-DB-Maintenance.zip
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10.

11.

In File Explorer, navigate to the folder you downloaded.
Extract the files from OIT-DB-Maintenance.zip..
From the extracted files, select and double-click dbmaintprepare.sql file.

If prompted How do you want to open this file? choose SQL Management Studio or SSMS. Click
OK.

Open SQL ServerManagement Studio, specify the server name, authentication type and Login and
Password to the ObservelT SQL instance (if connecting via SQL Server Authentication). Click Con-
nect.

If successfully completed, a confirmation message appears in the Messages pane.

Return to the File Explorer window. From File Explorer, select and double-click OIT-DB-Maint-
Create-Jobs.sql file.

From SQL ServerManagement Studio, select Query > Execute.

If successfully completed, a confirmation message appears under the Messages pane. Ignore any
warnings received.

Close the SQL Server Management Studio.
Open the Start menu and type in Run.
Type in services.msc to open the Services window. Press Enter.

Locate SQL Server Agent service.

42



observeir

a division of Proofpoint

% Services - o x
File Action View Help
IQ--Hr[rI'D_a__., Benl v muwn

|5 Services (Local) [ seemqocr

SO Server Agent (MSSQLSERVER)  Mame - Description  Status Seart
) G Secure Socket Tunneling Protocol Service  Provides su... Mant,
itac the service &) Security Accounts Manager Thestartup... Running  Autor
&, Sersor Data Senvice Delivers dat... Mant
Descraptian: Sy Sersar Monitoring Service Monitors va... Mant
Executes jobs, monitors SOL Serves, (5 sencor Service Aservice fo... Marn,
’,::‘:I:::::':Lm::ar“m" of -:’{‘_-},Ser\uer Supportsfil.  Running  Autor
" Shell Hardware Detection Provides no...  Running  Auter
G Smart Card Manages ac.. Disaby
‘5 Smant Card Device Enumeration Service Creates soft.. Funning  Mant.
-L"hSmnCard Ferneval Palicy Allows the 5., Man
Gy SNMP Trap Receives tra.. Mant.
Gl Software Protection Ensbles the . Autor
Gy Special Administration Consele Helper Allgws adem.., Mani
" Spot Verifier Verifies pote... Mant
{€,50L Full-text Filter Daemon Launcher (MSS... Senvicetola.. Running  Mant.
50U Server (MSSQLSERVER) Provides sto.. Running  Autor
=1 Agent | VER) Exec
), 50L Server Browser Provides SQ... Disab
{5} 50L Server CEIP service (MSSCASERVER)  CEP service.. Running  Autor
“5)50L Server VSS Writer Providesth., Running  Autor
5 SSDP Discovery Discoversn.. Running  Manw ¥
< >
Extended /|, Standard |

12. Right-click the service and click Properties.

['sQ Server Agent (MSSQLSERVER) Properties (Local Computer) x|
Gerwrnl LogOn  Recowery Dependencies
Service name:  SQLSERVERAGENT

Display name:  SQL Server Agert (MSSOLSERVER)

Desertion: Exacutes jobs, moniiors SGL Sanver, fres slads, and
allows automation of some administrative tasks.

Fath 1o executable:
“C\Program Fles'Mcresoft SOL Server\ MSSQL13 MSSQLSERVER'MS S

Sstmbpe | Auomabe Delyed 25t) -

Stat Sep Pause FResume
Yeu can spaciy the stat hat apply vwhan you start th
From here.

Start parameters: [

13. Change the value for Startup Type field to Automatic (Delayed Start).
14. Click Start.
15. Click OK.

16. Close the window.

Configuring Microsoft Internet Information Server (lIS)

The ObservelT Application Server and the Web Management Console are implemented as ASP.NET Web
applications that run on Microsoft Internet Information Server (11S) 8.0 or higher, depending on the
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Windows Server version.
You need to prepare Internet Information Services (IIS) for installing ObservelT Web applications.

If you have multiple Application Servers and/or a separate Web Console machine, you need to configure
I1S for each machine.

Related Topics:

OBTAINING A DIGITAL CERTIFICATE

Adigital certificate is the digital equivalent of an ID card used with a public key encryption system. Also
known as digital IDs, digital certificates are issued by trusted third parties known as Certification Author-
ities (CAs). This document assumes that the reader has prior knowledge of Public Key Infrastructure (PKI)
and its related terminology.

For further details, refer to the Microsoft Knowledge Base article, see How to implement SSLin IIS.

Digital Certificate Source

A digital certificate must be issued from a Certificate Authority (CA), either a 3rd-party commercial CA
(such as, Verisign, Thawte, Godaddy, Rapid SSL, and others), or from an internal CA. Third-party CAs sell
digital certificates at prices ranging from a few dollars to a few hundred dollars per year, depending on
the type of certificate issued, and other considerations, such as the CA's reputation.

However, most operating systems are preconfigured to trust a list of known 3rd-party CAs. This facilitates
deployment since you do not need to import anything to the computers running the ObservelT Agents.
To avoid paying for a digital certificate, you can use an internal CA. Note that Windows Server 2008/2012
has a built-in CA that you can install and use.

In cases where an internal CAis not required, or where such a deployment cannot be achieved, you can
also use a Self-Signed Digital Certificate.

After a digital certificate is obtained, you must import the root CA digital certificate or the self-
signed digital certificate to each client computer running the ObservelT Agent, so that they trust
your digital certificate source.

Digital Certificate Common Name

1. When issuing a digital certificate for the ObservelT Application Server, you must make sure that
the Common Name field or the Issued to field on that certificate contains the same name as the
URL of the ObservelT Application Server.
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115 Certificate Wizard

Your Site's Common Hame
Your Web zite's common name ig itz fully qualified domain name.

Type the comman name far paur zite, [F the zerver iz on the ntermet, uze a valid DS
name. If the server ig on the intranet, you may prefer to uze the computer's MetBIOS5
Narie.

If the common name changes, you will need to obtain a new certificate.

Comman narme:

132.165.200.33

< Back

Cancel |

For example, if the ObservelT Agents use the following Fully Qualified Domain Name (or FQDN) t

connect to the ObservelT Application Server:
server100.mydomain.local

Then the same exact name MUST be used when issuing the digital certificate for the ObservelT
Application Server.

When connecting to the ObservelT Application Server, an IP address can be used instead of an
FQDN. If the following IP address is used by the Observel T Agents to connect to the ObservelT
Application Server:

192.168.200.33

The same exact IP address MUST be used when issuing the digital certificate for the Observel T
Application Server.

at ObservelT.ClientSetupActions.ClientInstaller.Install(IDictionary stateSaver)

If you do not follow these guidelines, an error message similar to one of the following appears:

System.Net.WebException: The underlying connection was closed: Unable to connect to the
remote server.

at ObservelT.ClientSetupActions.RegisterServerManager.GetLicenseStatus()

0]
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at ObservelT.ClientSetupActions.ClientInstaller.Install(IDictionary stateSaver)
_Or'_

System.Net.WebException: The underlying connection was closed: Could not establish trust rela-
tionship with remote server.

at System.Net.HttpWebRequest.CheckFinalStatus()
at System.Net.HttpWebRequest.EndGetRequestStream(IAsyncResult asyncResult)
at System.Net.HttpWebRequest.GetRequestStream)

at System.Web.Services.Protocols.SoapHttpClientProtocol.Invoke(String methodName, Object(]
parameters)

at ObservelT.ClientSetupActions.Proxy.HeartBeatPrxClone.IsAlive()

While not viewable by the ObservelT Agent, if you manually try to connect to the Observel T
Web Console while using an FQDN or IP address that does not match the one listed in the
server's SSL digital certificate, a warning appears in the Web browser, similar to that shown
in the following screenshot.

('Eertificate Error: Mavigation Blocked - Windows Internet Explorer

6@ - |g, https:,l’,l'oitvirtual,l’observeit,l’CaIendarTabIeView.aspx?GroupIndex=1&TabIndex=1&]ang=ej 4| K ILive Search Peiis
Fle Edit \iew Favorites Tools Help
Gc(;glc“Cv jGo +@ Er ~ | 7 Bookmarksw PaseRank o B8 o blocked | F Check ~ % Autolink = > () Settings =
= = 2
'i:f ke '_',éCertiFicate Error: Mavigation Blocked | | @ - & - .- E}’Eage v {0 Tools ~
=

|@ There is a problem with this website's security certificate.

The security certificate presented by this website was issued for a different website's address,

Security certificate problems may indicate an atternpt to fool you or intercept any data you
zend to the server.

we recommend that you close this webpage and do not continue to this website,

@ Click here to close this webpage.

& iContinue to this website (not recommended?

@ More information

=
| [T T [ [@ meeme | R0 ~

If you click Continue to this website (not recommended), you can view the digital certificate error
message (by clicking the button).
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ASSIGNING A DIGITAL CERTIFICATE

This topic describes how to assign a digital certificate for the Web Console. You can use the Microsoft
Management Console or Internet Information Services (IIS) Manager.

ObservelT Recommendations:
e Always assign a certificate

e Encryptthe Web Console traffic by using HTTPS.

Consult with your organization’s security team to learn what type of digital certificate best fits
your environment. When it is not possible to acquire a Certificate Authority certificate, a self-
signed certificate may be used.

In most instances, the Web Console is deployed on the only ObservelT Application Server in a
smaller deployment or one of the ObservelT Application Servers in case of a larger deployment. It
is also possible to deploy the ObservelT Web Console on a separate server.

(The following assumes an Enterprise Certificate Authority certificate is used.)

Using Microsoft Management Console

You can create an internal Enterprise Certificate Authority certificate for the Web Console using Microsoft
Management Console.

1. From the Start menu and type mmcin the Run window. Enter.
If prompted Do you want to allow this app to make changes to your device? click Yes.

The Microsoft Management Console window opens.

2. From the menu, select File > Add/Remove Snap-in.
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Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For

extensible snap-ins, you can configure which extensions are enabled.
Available snap-ins: Selected snap-ins:
Snap-n Vendor A ["] Console Root

[ Ya N a0 Wl Microsoft Cor...

[B Active Directory Site... Microsoft Cor...
j Active Directory Use... Microsoft Cor...

=" ActiveX Control Microsoft Cor...
2’ ADsI Edit Microsoft Cor...
Auﬂ'norization Manager Microsoft Cor... Add >
Gl Certificates Microsoft Cor...

:"_— Component Services  Microsoft Cor...
A computer Managem... Microsoft Cor...

Device Manager Microsoft Cor...
[ Disk Management Microsoft and...
{4 Event Viewer Microsoft Cor...
_| Folder Micosoft Cor... ,
P - - - - -
Description:

Edit Extensions...

Remove

Move Up

Move Down

You can use the Active Directory Domains and Trusts snap-in to manage Active Directory domains and trusts.

[ o< |

From Available snap-ins choose Certificates and click Add.

In the Certificates snap-in window choose Computer account and click Next.

In the Select Computer window, from Select the computer you want this snap-in to manage

options, select Local computer and click Finish.
Click OK to return to the Console window.
Expand Certificates (Local Computer).

Right-click Personal, select All Tasks and then Request New Certificate.
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i Consolel - [Console Root]
@ File Action View Favorites Window Help

«s [ = HiE

| Console Root Name
v 5 C_emflcates (Local Compute & Centificates (Local Computer)
_| Personal |
- Truste Find Certificates...
-] Enterp i i
% Interm All Tasks > Find Certificates...
1 Truste New Window from Here Request New Certificate...
| Untrus et
| Third-  Refresh S
J Tr-f.uste Help Advanced Operations »
| Client . ..,

*| Preview Build Roots
“|_Remote Desktoo

9. Click Next to close the Certificate Enrollment message. The Certificate Enrollment Policy page
opens.

10. In the Select Certificate Enroliment Policy page select your enrollment policy (usually — Active Dir-
ectory Enrollment Policy) and click Next.

- (] b4
] Certificate Enrcliment
Certificate Installation Results
The following cetificates have been enrolled and installed on this computer.
Active Directory Enrollment Policy
Computer o STATUS: Succeeded Details »
e ]

11. Inthe Request Certificates page select the certificate type (usually—Computer) and click Enroll.
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= o X
[Cgl Centificate Enrollment
Certificate Installation Results
The following certificates have been enrolled and installed on this computer.
: Active Directory Encoliment Policy |
Computer o STATUS: Succesded Details
(i ]

12. Click Finish when the enrollment is successfully completed to close the window.

13. Confirm the newly-created certificate exists, ffrom the console, select Personal> Certificates.

The FQDN of the current server displays in the Issued To column.

Q'i! Server Certificates

Use this feature to request and manage certificates that the Web server can use with websites configured for S5L.

Filter: * W Go - (g ShowAll |Groupby: No Grouping v

Name Issued To Issued By
SUP1W2016.5UPP.LOCAL SUPTW2016.5UPP.LOCAL 8/12/2020 1:54:53 ...
SUPTW2016.5UPP.LOCAL SUPP-DC-SUPP1-CA 9/10/2020 10:16:00...

Using Internet Information Services (1IS) Manager

You can create a self-signed certificate for the Web Console using the II1S Manager.

1. Connectto the ObservelT Web Console machine.

2. Open Internet Information Services (11S) Manager .

3. In Connections area on the left, select the relevant server and double-click the Server Certificates

icon at the main page.

4. Inthe Actions area on the right, click Create Self-Signed Certificate.
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5. Inthe Specify a friendly name for the certificate field, enter a descriptive name for the certificate.
Click OK.

CREATING A NEW APPLICATION POOL IN IIS 8.X

When installing ObservelT, the installer automatically creates a new application poolin IS and uses it for
the ObservelT server-side component installations. If a custom installation is required, you can manually
create the application pool and configure the website to use it when installing the ObservelT server-side
components.

The application pool must be configured as Integrated in order to use it for the ObservelT server-
side component.

You can create an application pool manually or use Powershell commands.
To create a new application poolin IIS 8.X for the Application server (Manual):

1. OntheserverrunningIIS, open IS Manager from the Administrative Tools folder. Expand your
server name.

51



observeir

a division of Proofpoint

2. Right-click Application Pools and select Add Application Pool.

"E Internet Information Services (IIS) Manager

=10l x|

@‘) [Q » CESVOIT b Appiication Pools

j& 518 -

Fle View Help

Q- i |2 |8 ﬁ;’ Application Pools
;g Start Page Th lets you view and the list of application podls on thi Application pocl
= » is page lets you view and manage the list of application pools on the server. Application poals are
B j D.ES VOIT (QBSERVEIT-SYS\administrator) assodated with worker processes, contain one or more applications, and provide isolation among different
ol ~ S
..ﬁ Default | - %GD - %Shcw Al |GrouD by: Mo Grouping -
853 Refresh
la [ stetws [ .NET Frame... [ Managed Pipeline Mode | Identity [«
Edam’( .NET App... Started v2.0 Classic ApplicationPoollden...
QDefau\tAppPool Started v2.0 Integrated ApplicationPoollden... 1
| -
Ready

Q Add application Poal. ..

Set Application Pool Defaults...
Application Pool Tasks
Start

Stop

Recyde...

e

Edit Application Pool

Basic Settings...

@

Recyding...
Advanced Settings...

Rename
‘l( Remove
View Applications

@ Help

Online Help

9

3. Inthe Add Application Pool dialog box:
1. Inthe Name field enter ObservelTApp. (The Application Pool name must not contain

spaces.)

2. Inthe Managed pipeline mode column, select Integrated from the list.

3. Click OK.
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Add Application Pool | 2 [

Mame:
|Ob5er\reITApp| ‘

MET CLR version;
| NET CLR Version v4.0.30319 v|

Managed pipeline mode:

| Integrated W ‘

Start application pool immediately

0K ‘ | Cancel

The new application pool appears in the Application Pools list.

If you have multiple Application Servers and/or a separate Web Console machine, you need to
repeat this process for each.

For example:

OITsrvl —Application Server #1 —would hold a single Observel TApplication Application Pool.
OITsrv2 — Application Server #2 —would hold a single Observel TApplication Application Pool.
OITweb —Web Console —would hold a single ObservelTWebConsole Application Pool.

To create a new application poolin I1S 8. X for the Application server (PowerShell):
Open PowerShell as administrator and paste the following commands:

$WebSiteName = 'ObserveITApplication'
Import-Module WebAdministration

New-Item IIS:\Sites\$WebSiteName -PhysicalPath 'C:\Program Files\Ob-
serveIT\Web\' -Bindings Q{pro-
tocol="https" ;bindingInformation=":443:"}

Set-ItemProperty IIS:\Sites\$WebSiteName\ -Name applicationpool -
Value $WebSiteName

To create a new application poolin IS 8. X for the ObservelT Console (manual):
1. Open Internet Information Services (IIS) Manager .

2. In Connections area on the left, select the relevant server and select Sites.
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10.

Right-click Sites and select Add Website.
In the Site Name field type in ObservelTApplication.
Click Select (next to the Application Pool field).

Select the ObservelTApplication Application Pool. Click OK.

Add Website 7] 0%

Site name:

|Ob5er\reIT Web Site | |Obser\.reIT Web Site | Select...

Content Directory

Physical path:

[C:\ObservelT Web Site 1[.. ]

Pass-through au Select Application Pool |_? JIIHN|

Appiation oot

| ObservelTApp W |

Bindi

fEehz Properties:

Type:

hittp et CLR Version: 4.0

Pipeline mode: Integrated

Host name:

— e
Example: www.c

Start Website immediately
| oK | | Cancel |

Navigate to the following path: C:\Program Files\ObservelT\Web. Click the Web folder. Click OK.

Click Select (next to the Application Pool field).

If you cannot find the “ObservelTApplication” application pool make sure you properly cre-
ated the application pool before creating the website.

In the Binding area, in the Port field, change the port value from 80 to 443.

Click OK to save the changes and create the new website.

If you have multiple Application Servers, you need to repeat this process for each machine.
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For example, if you plan to use the following setup:

e QOlITsrvl—Application Server #1

e OITsrv2—Application Server #2
The result would be to have an identical website using the same name and application pool on the
2 machines that will act as the Application Servers.

When modifying an existing website, you need to configure that website to use this new application pool,
as follows:

1. Select the existing website in the Sites list, and click the Advanced Settings link for that website.

2. Inthe Advanced Settings window, click the Application Pool section, and then click the [...] button
next to the existing application pool.

3. Inthe Select Application Pool window, from the Application pool list, select Observel TApp.
4. Click OK

Advanced Settings IZII'

4 (General)

Application Pool ObservelT Web Site
Bindings http:*:8000:
1D 2
Name ObservelT Web Site
Physical Path C\DbservelT Web Site
P Select Application Pool ?
p
P Application pook
. ObservelTApp W |
4 B
Ed Properties:
BoLi
Met CLR Version: 4.0
Pipeline mode: Integrated
oK | | Cancel
Application Pool

[applicationPool] Configures this application to run in the specified
application pool.

| OK | | Cancel

Click OK to close the Advanced Settings window.

To create a new application poolin I1S 8. X for the ObservelT Console (Automatic - PowerShell):
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Open PowerShell as administrator and paste the following commands:
$WebSiteName = 'ObserveITApplication'
Import-Module WebAdministration

New-Item IIS:\Sites\$WebSiteName -PhysicalPath 'C:\Program Files\Ob-
serveIT\Web\' -Bindings Q{pro-
tocol="https" ;bindingInformation=":443:"}

Set-ItemProperty IIS:\Sites\$WebSiteName\ -Name applicationpool -
Value $WebSiteName

Creating a New Application Poolin IIS 7.X

Creating a New Website in IS 7.X

CREATING A NEW WEBSITE IN 1IS 8.X FOR THE OBSERVEIT APPLICATION
SERVER

When installing ObservelT, the installer automatically creates a new website in 1IS and uses it for the
ObservelT server-side component installations.

In a custom installation, you can create an additional website in 1S, and use this site to host the
ObservelT Application and Web Management virtual directories. However, in order to run multiple web-
sites on the same |IS server, the listening IP address of each website, the listening TCP port of each web-
site, and/or the Host Header of each website, must remain unique.

To create a new website for the ObservelT Application Server (Using the Wizard - Manual):

1. Ontheserver running IS, open IS Manager from the Administrative Tools folder. Expand your
server name, then expand Sites.

2. Right-click Sites and select Add Website.

3. Follow the steps in the Web Site Creation Wizard. Make a note of the listening IP address of the
new website, the listening TCP port of the new website, and/or the Host header of the new web-
site.

4. Inthe Site Name field type ObservelTApp. Click Select.

5. From the Application pool dropdown, select ObservelTApp and click OK.
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Site narme: Application pool:

| ObservelT Web Site | | ObservelT Web Site

Content Directory

Physical path:
| C:\ObservelT Web Site

Pass-through authentication

Connect as... Test Settings...

Binding
Type: IP address:
|http v| |A.II Unassigned v| |30‘9G1

Host name:

Example: www.contoso.com or marketing.contose.com

[+ Start Website immediately

6. From the Physical path field, navigate to the following path: C:\Program Files\ObservelT\Web.
Select the Web folder and click OK.

7. Clickthe Select button next to the Application pool field

If you cannot find the “ObservelTApplication” application pool make sure you properly cre-
ated the application pool before creating the website.

8. Inthe Binding area, in the Port field, change the port value from 80 to 443.
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Add Site Binding ? =

Type: IP address: Part:
hittps w | |All Ungssigned | (443

Hesst name:

] Require Server Name Indication

S5L certificate
SUPTW2016.5UPR.LOCAL bt Select.. View-..

9. Click OKto save the changes and create the new website.

10. If you have multiple Application Servers, you need to repeat this process for each machine.
For example, if you plan to use the following setup:
OITsrvl — Application Server #1
OITsrv2 —Application Server #2

The result will be to have an identical website using the same name and application pool on the 2
machines that will act as the Application Servers.

To create a new website in |1S 8.x for the Application Server (Automatic - Powershell):
Open PowerShell as administrator and paste the following commands to execute above steps auto-
matically.

$WebSiteName = 'ObserveITApplication'
Import-Module WebAdministration

New-Item IIS:\Sites\$WebSiteName -PhysicalPath 'C:\Program
Files\ObserveIT\Web\' -Bindings @
{protocol="https" ;bindingInformation=":443:"}

Set-ItemProperty IIS:\Sites\$WebSiteName\ -Name applicationpool -
Value $WebSiteName

CREATING A NEW WEBSITE IN 11S 8.X FOR THE OBSERVEIT WEB CONSOLE

You can create an additional website in IIS.
To create a new website for the ObservelT Web COnsole(Using the Wizard - Manual):

1. Ontheserver runningIIS, open IS Manager from the Administrative Tools folder. Expand your
server name, then expand Sites.

2. Right-click Sites and select Add Website.
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3. Follow the steps in the Web Site Creation Wizard. Make a note of the listening IP address of the

new website, the listening TCP port of the new website, and/or the Host header of the new web-
site.

4. Inthe Site Name field type ObservelTApp. Click Select.

5. From the Application pool dropdown, select ObservelTWebConsole and click OK.

6. From the Physical path field, navigate to the following path: C:\Program Files\ObservelT\Web.
Select the Web folder and click OK.

7. Click the Select button next to the Application pool field

If you cannot find the “ObservelTWebConsole”application pool make sure you properly cre-
ated the application pool before creating the website.

8. Inthe Binding area, change the value from http to https. The value of the Port field will be auto-
matically changed from 80 to 443.

Add Site Binding [ x

Type: 1P address: Part:
hittps | | All Unassigned w| 443

Hesst name:

[[] Require Server Mame Indication

SEL certificste
SUPTW2016.5URP.LOCAL ~ Select...

9. Inthe SSL certificate field select a certificate you have previously created.
10. Click OKto save the changes.
For example, if you plan to use the following setup:

To create a new website in |I1S 8.x for the Application Server (Automatic - Powershell):
Open PowerShell as administrator and paste the following commands to execute above steps auto-
matically.

SWebSiteName = 'ObservelTWebConsole'
Import-Module WebAdministration

New-Item IIS:\Sites\$WebSiteName -PhysicalPath 'C:\Program
Files\ObserveIT\Web\' -Bindings @
{protocol="https" ;bindingInformation=":443:"}
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Set-ItemProperty IIS:\Sites\$WebSiteName\ -Name applicationpool -
Value $WebSiteName

Installing ObservelT Components

Installing ObservelT components includes the following servers and modules:
e QObservelT Application Server
e ObservelT Web Management Console
e SQL Native Client
e Screenshot Storage Optimizer

e Web Categorization Module

INSTALLING OBSERVEIT APPLICATION SERVER

Depending on the sizing and architecture of the product deployment, you must install one or more
ObservelT Application Server(s).

This Application server is installed after you install the database and file server.

Application Server File Server
Windows Server + IS

SME traffic
(445)

sQL traffic
(1433 or 443)

This topic describes how to install and verify the Observel T Application Server component on the first
server. If you have multiple Application Servers, you need to repeat this procedure for each machine.

Do not attempt to install ObservelT server-side components over the network. Always use a local
copy of the installation files.
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Micro

Prerequisite for installing the ObservelT Application Server: Download the most recent version of

soft ASP .Net Core Runtime Windows Hosting Bundle.

Installi

1.

10.

11.

12.

ng ObservelT Application Server (Manual)

From the Command Prompt, select Run as administrator.

If porompted, Do you want to allow this app to make changes to your device?, select Yes.

Navigate to the folder with the extracted ObservelT Installer. Navigate to the Web folder.

For example:

c:\Users\OITServiceAccount\Desktop\ObservelIT Setup vx.x.x.xx\Web

Run PreRequisite_nodeServices.exe.
Check the check box with the message | agree to install the following products and click Install.

Wait for the installation to finish and then click Close.

From the command line, as an administrator, navigate to the folder with the extracted ObservelT
Installer. Navigate to the Web folder.

Forexample: cd c:\Users\OITServiceAccount\ObserveIT Setup
vx.x.x.xx\Web\AppServer

Open the Start menu and type Command Prompt.

Right-click the Command Prompt shortcut icon and select Run as administrator.

If porompted Do you want to allow this app to make changes to your device?, click Yes.

From the command line, as an administrator, navigate to the folder with the extracted ObservelT
installer. Navigate to the Web folder.

Forexample:cd c:\Users\OITServiceAccount\ObservelIT Setup
vX.x.xX.xx\Web\AppServer

Type ObservelT.AppServerSetup.msi and Enter.

In the ObservelT Application Server window click Next.

In the Site field, select ObservelTApplication.

In the Application Pool field, select ObservelTApplication. Click Next.

In the Server field, enter the details of the SQL server, in the following format:
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<ServerFQDN>\<InstanceName>, <Port>
Forexample: SQLsrv.test.lab\ObservelIT, 1433

13. Select the Windows Authentication radio button and enter the password for the current account
—the ObservelT Service Account - in the Password field. Click Test Connection.

If the test is successful, a success message displays, and the Next button becomes available.
14. Click Next. The installation begins.
15. After successful installation, click Close.

Installing ObservelT Application Server (Powershell - Automatic)
Open PowerShell as administrator and paste the following commands to execute above steps auto-
matically.

The following command assumes the ObservelT installer is located under the C:\Temp\ObservelT-_
Setup_v7.8.2.270 path. After the execution of the command, the installation will starts — just follow the
prompts.

iisreset /stop
Get-Service WAS | Start-Service

Start-Process msiexec -ArgumentList '/i', "C:\Temp\ObserveIT-_Setup_
v7.8.2.270\Web\AppServer\ObservelT.AppServerSetup.msi", '/norestart',
'/1*v ObserveITWebConsole setup.txt' -Wait

iisreset /start
Verifying Application Server Installation
1. Connect to the ObservelT Web Console machine.
2. Open the Start menu and type Run. Enter.
3. Type Suserprofile%\AppData\Local\Temp. Enter.
4. locate AppServer CA Log.txt file. Double-click the file to open it.
5. Open the Find dialog. (Press CTRL+F on the keyboard.) Find RegisterApplicationServer

6. Locate the following line: RegisterApplicationServer: Done.

Ifthe line does not exist or the word Done does not exist —the installation failed. Re-check the
installation requirements, particularly the permissions for the SQL logins.
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Installing Additional ObservelT Application Servers

Depending on your deployment design and the number of concurrent recorded sessions, you may need
to deploy additional ObservelT Application Servers.

Before installing an additional Application Server, you must obtain a valid license from the
ObservelT Sales team.

When deploying more than one Application Server, you need to load balance the Agent connections with
the multiple Application Servers.

The steps required to install additional Application Server(s) and verify its successful installation are
identical to the steps required for installing and verifying the first Application Server.

LOAD BALANCING

Depending on your deployment design and the number of concurrent recorded sessions, you may need
to deploy additional ObservelT Application Servers.

When deploying more than one Application Server, you need to load balance the Agent connections with
the multiple Application Servers. You may use software-based load balancing solutions, such as Microsoft
Network Load Balancing (NLB), or hardware-based solutions, such as F5, Citrix NetScaler, or others.

Expected reply: 200

For example:
{" status":{"status":200,"code":"it:error:none", "context":{"trans-
actionId":"","correlationId":""}}," meta":{"origin":{},"stats":

{}},"status":"Healthy", "database™":
{"status":"Healthy", "roundTripTime":"00:00:00.0017518"},"fileSystem":
{"status":"Healthy", "roundTripTime":"00:00:00.0033923"}}

You can change the health check interval to 10 seconds by editing the HealthCheck-
SecondsInterval value in the web.config file on the Application Server(s).

INSTALLING OBSERVEIT WEB MANAGEMENT CONSOLE

The ObservelT Web Console is the component that is used to configure, administer and use the product.
Multiple Web Consoles can be installed in an environment for redundancy purposes.

In most cases, the Web Console is installed on the same machine as the Application Server (the first one,
in case of multiple Application Servers). However, it’s also possible to configure a dedicated machine for
this.
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The time displayed in the Web Console is defined by the time zone of the database. Therefore, it is
recommended that the Web Console and Database are installed with the same time zone.

Before you can verify the Web Console installation you must install the SQL Native client. This lets you
work with ObservelT REST APIs.

Application Server Files Server
Windows Server + I55

‘:: o3 0} e
-

&
T

Y
('§

Prerequisite for installing the Web Management Console: Download the most recent version of
Microsoft ASP .Net Core Runtime Windows Hosting Bundle.

Installing the Web Management Console (Manual)

1. Connect to the computer where you downloaded and extracted the ObservelT setup files.

If unable to log in as the ObservelT Service Account interactively, see Running elevated
Windows PowerShell prompt as a different user.

2. Open the Start menu and type in Command Prompt.
3. Right-click the Command Prompt shortcut found and choose Run as administrator.
4. If prompted Do you want to allow this app to make changes to your device? click Yes.
5. Navigate to the folder with the extracted ObservelT installer. Navigate to the Web folder.
For example:
c:\Users\OITServiceAccount\Desktop\ObservelIT Setup vx.x.x.xx\Web"
6. Run PreRequisite_nodeServices.exe.

7. Checkthe check box with the message | agree to install the following products and click Install.
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10.
11.
12.
13.

14.

15.

16.

17.

18.

Installi

Wait for the installation to finish. Click Close when it does.

Navigate to the folder with the extracted ObservelT installer. Navigate to the Web\WebConsole
folder.

Forexample: c: \Users\OITServiceAccount\Desktop\ObservelIT Setup
vx.x.x.xx\Web\WebConsole

Type in Observel T.WebConsoleSetup.msi and Enter.

In the ObservelT Console window click Next.

In the Site field select ObservelTWebConsole.

In the Application Pool select ObservelTWebConsole. Click Next.

Opt-out of the anonymous data usage submission if required.

Choose whether you opt-out of ObservelT collecting anonymous usage data of the Web Console
use.

In the Server field enter the details of the SQL server, in the following format:
<ServerFQDN>\<InstanceName>, <Port>

Forexample: SQLsrv.test.lab\ObserveIT, 1433

Click the Windows Authentication radio button and enter the password for the current account —
the ObservelT Service Account - in the Password field. Click Test Connection.

If the test is successful, a success message displays, and the Next button becomes available.
Click Next. The installation begins.
After successful installation, click Close.

ng the Web Management Console (Automatic)

To work with ObservelT RESTful APIs, SQL Native Client is required.

1.

2.

Installi

To install the SQL Native Client, download

https://download.microsoft.com/download/F/E/D/FEDB200F-DE2A-46D8-B661-
DO19DFE9D470/ENU/x64/sqglncli.msi.

After downloading, execute sgincli.msi, and follow the Wizard to complete the installation.

ng the Web Console

Open PowerShell as administrator and paste the following commands, substituting the relevant location.
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The example below assumes the ObservelT installer is located under the C:\Temp\ObservelT-_Setup__
v7.8.2.270 path.

After executing the commands bwlow, the installation wizard will
start - just follow the prompts.

Start-Process "C:\Temp\ObserveIT Setup v7.8.2.270\Web\PreRequisite
nodeServices.exe" -Wait

Start-Process "C:\Temp\ObserveIT Setup v7.8.2.270\Web\sqlncli-2012-
64-QFE .msi" -Wait

iisreset /stop
Get-Service WAS | Start-Service

Start-Process msiexec -ArgumentList '/i', "C:\Temp\ObserveIT Setup
v7.8.2.270\Web\WebConsole\ObserveIT.WebConsoleSetup.msi",
'/norestart', 'EXTRACTMICROSERVICES=True',6 '/l*v ObserveITWebConsole _
setup.txt' -Wait

iisreset /start
Installing the SQL Native Client

(Manual)

1. Download the file: https://download.microsoft.com/download/F/E/D/FEDB200F-DE2A-46D8-B661-
DO19DFE9D470/ENU/x64/sqglncli.msi.

2. After downloading, execute the sqlncli.msi file, and follow the wizard to complete the installation.
(Powershell - Automatic)

Open PowerShell as administrator and paste the following commands to execute above steps auto-
matically.

The below command assumes the ObservelT installer is located under the C: \Temp\ObserveIT-
Setup v7.8.2.270 path. After the execution of below command, the installation wizard starts —just
follow the prompts.

Start-Process "C:\Temp\ObserveIT Setup v7.8.2.270\Web\PreRequisite
nodeServices.exe" -Wait

Start-Process "C:\Temp\ObserveIT Setup v7.8.2.270\Web\sqlncli-2012-
64-QFE .msi" -Wait

iisreset /stop

Get-Service WAS | Start-Service
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Start-Process msiexec -ArgumentList '/i', "C:\Temp\ObserveIT Setup
v7.8.2.270\Web\WebConsole\ObserveIT.WebConsoleSetup.msi",
'/norestart', 'EXTRACTMICROSERVICES=True',6 '/l*v ObserveITWebConsole
setup.txt' -Wait

iisreset /start
Verifying the Web Management Console installation
1. Connect to the ObservelT Web Console machine.
2. Open the Start menu and type Run. Enter.
3. Type $userprofile%\AppData\Local\Temp. Enter.
4. locateWebConsole CA Log.txt file. Double-click the file to open it.
5. Open the Find dialog. (Press CTRL+F on the keyboard.) Find RegisterWebConsole.

6. Locate the following line: RegisterWebConsole: Done.

Ifthe line does not exist or the word Done does not exist — the installation failed. Re-check the
installation requirements, particularly the permissions for the SQL logins created previously in this
guide.

OBTAINING A COMMERCIAL LICENSE

When you install the ObservelT server-side components using the ObservelT Custom Installation, your
product will not be licensed. The first time that you access the Web Management Console, you will need
to install a license to be able to use the product.

Using a Full Paid License (Enterprise version)

This license is generated at the customer's request by ObservelT's support staff, and represents the num-
ber of Agents (monitored servers) that were purchased by the client.

If you are installing ObservelT for a client that has not yet received the full paid license, you can tem-
porarily use the free time-limited license, and later upgrade the license to the paid one.

Some full paid licenses have a time limit. If a license has a time limit, a notification is displayed at
the top of the screen in the Web Console showing the number of days left till the expiration date,
and a hyperlink to contact the ObservelT website at: http://www.observeit.com/request-pricing
in order to request a license extension. If a time-limited license is due to expire in less than 30
days, the message will appear highlighted in the Web Console.

To obtain and activate a Commercial License
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1. Gotothe ObservelT website: http://www.observeit.com/request-pricing.

2. Fillin the customer details and click Submit.

Make sure that you use a corporate valid email address. Free email hosting addresses, such
as Hotmail or Gmail, will not be accepted.

3. Obtain avalid serial number which is generated at the customer's request by ObservelT's sales
staff, and represents the number of Agents (or monitored servers) that were purchased by the cli-
ent.

4. Insert the serial number using the ObservelT Web Console.

When using the default TCP port 4884, use the following URL to connect to the ObservelT Web
Console: http://servername:4884/ObservelT, where servername is the name or IP of the server on
which the ObservelT Web Console is installed.

5. Inthe Web Console, open the License page by selecting Configuration > License.

Note If the current license has a time limitation, the expiration date and number of days left
until the expiration date are included in the License information, as shown below. In addi-
tion, a notification appears at the top of the screen with a hyperlink to contact the
ObservelT website at: http://www.observeit.com/request-pricing for details about extend-
ing the license.

Licerne
nse Infarmation
Compary Nama CibgerselT Evaluation Licente
Coracr Mams CogenaalT
Phang 1-$00-857-0137
Emnail FelpRobiervaitiom
Addrass 500 Boyiszon Strest, Boston WA 0211 US4

Ragiszravon Dace W20

[E'P “aiien Qe EINT0NE [ 188 dayr) ]
E  Towl Number of Installed Agenis
H  Toml Number of Registered Agencs 2000

6. Clickthe Change License link.

The Activate Software page opens.
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Activate Software

Activate Your Commercial License

Please enter your Serial Number and press on the "Generate Registration Key” butten. Send the
generated registration Key to ObsenvelT licensing.

If you haven't already purchased ObservelT Commercial, please contact us for pricing.

Serial Number: |

Generate Registration Key |

License File

Select your license file and click Activate.

License File: | Browse... | | Activate |

Note: If a time-limited license has expired, the Activate Software page will open after you log in to
the Web Console warning you that your commercial license has expired and enabling you to activ-
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ate your renewed commercial license. For example:

Activate Software
Vour commercial license has been gxpared

— Activate Your Renewed Commercial License

Please enter your Sesial Numes and press on ihe "Ganerate
Regitiration Key™ bulion. Send the generaled registration Key 1o

QoservelT licknsing
I you haven't already purchased a renewed Commercal
license, please Contad ys for pricing.

Serial Mumber:

Generate Registration Key

—License File

Selelt your license fle and click Activate.

License File Ghoose File | Mo fle chosan Actvate

7. Paste the Serial Number and click the Generate Registration Key button.

8. Copythe registration key, paste it into a new email message, and send it back to oit-sales @-
proofpoint.com.

You will receive an automated email containing a license file in the format of a .lic file.

9. Inthe License File section of the Activate Software page, click Browse to find the license file that
was provided to you by the ObservelT sales team.

10. Clickthe Activate button to use the specified license file.
After your product has been activated, the Web Console Login screen willimmediately open.
ObservelT License Types

The License page displays the number of licensed computers.
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License Infarmation

Cﬂfﬂﬂaﬂ}' Name unix - dev Evaluation License
Contact Name ObsarvelT
Phane 1-800-687-0137
Emgail MIp@nhsamemm
Addrass 500 Bayleton Strast, Soston MA 0211 USA
Reqistration Date SME2014
Expiration Date S/30/2017 {in 78 days)
Bl Total Mumber of Instalied Agents 10

Worketations 3700

Endpoints 1798

Terminal Senvices 0rag

Ulnit 6199

Sites 0/99

ACTveX 0

Bl Total Mumber of Registered Agents 495

Workstations 6o

Endpoints oo

Terminal Services BE

Unix oo

Sites 6o

Total Number of Installed Agents shows the number of Agents that were actually installed and
used.

Total Number of RegisteredAgents shows the number of licenses that were purchased by the cli-
ent.

There are several license types:

Workstations: Licensed computers running the Workstation type license. This license is for com-
puters running Windows Vista/7/8/10 and Mac operating systems.

Endpoints: Licensed computers running the Server type license. This license is for computers run-
ning Windows Server 2008/2008 R2/2012/2012 R2.

Terminal Services: Licensed computers running the Terminal Server type license. This license is for
computers running Windows Server 2008/2012 with the Terminal Services role installed, or for Win-
dows Server 2008 R2 with the Remote Desktop Services role installed (note that on Windows Server
2008 R2, the Terminal Server role name was changed to Remote Desktop Services).
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e Sites: Licensed computers running the Site type license. This license is for computers running any
version of Windows operating system.

In this context, "Servers" relates to the operating system type that is installed on the monitored
endpoint.

The client can install additional Agents for the type of license that they have, providing that they have
available licenses.

For example: If the client bought 50 Workstation licenses and 25 Server licenses, they can install up to 50
Agents running on Windows Vista/7/8/10, and up to 25 Agents running on Windows Server 2008/2008
R2/2012. If the client wants to install an additional Workstation Agent or an additional Server Agent, they
cannot do so, because no free Agents remain. However, if the client bought 75 Site licenses, they can
install these 75 Agents on any type of operating system (Windows or Unix), as long as the total number of
Agents does not exceed the 75 licenses. If the client has already used up all the available licenses for that
type of Agent, to install an additional Agent the client must uninstall and unregister one existing Agent
(which will free up one license, making it available for a new machine), or purchase at least one additional
license based upon the required installation type.

INSTALLING THE SCREENSHOTS STORAGE OPTIMIZER

ObservelT can store sessions with full video recording in the file system or in the SQL database. Archiving
full sessions with many screenshots takes up processor time and bandwidth.

If configured, ObservelT will store sessions on "Hot" Solid State Drive (SSD) based devices to provide
faster session archiving. After sessions stored in the SSD-based Hot storage are closed and signed, the
Screenshots Storage Optimizer packs and zips session video on an SSD-based "Warm" storage device.
This speeds the archiving process and uses less processor time.After sessions stored in the SSD-based
Hot storage are closed and signed, the Screenshots Storage Optimizer packs and zips session video on a
"Warm" storage device. This speeds the archiving process and uses less processor time."

The Screenshots Storage Optimizer can be installed anywhere on the same domain as the
ObservelT Application server and Web Console. It must have access to the “Hot” and “Warm”
storage folders. More specifically, we recommended installing it directly to the SSD-based "Hot"
storage drive where the "Hot" storage folder is configured.

Access to Advanced Web Console Setup is required to complete the Screenshot Optimizer installation.

During installation of Screenshot Storage Optimizer version 7.9, you’ll be asked to provide an
installation configuration file that contains a token for authentication. This file can be downloaded
from Service Settings in the Configuration tab from the ObservelT Web Console.

Installing the Screenshot Storage Optimizer (Manual)
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Navigate to the ObservelT Web Console (from your Internet broowser), for example https://
OITsrv1l/ObservelT.

When prompted by the ObservelT Web Console, set up the password for the build-in admin user.
From License File, click Choose File and select your ObservelT license. Click Activate.

In the ObservelT Web Console, select Management Console > Configuration and select Service Set-
tings on the left.

Click the Download button for the Screenshot Storage Optimizer service.
Save the file to the ObservelT Console server.

Connect to the Web Console machine, where you downloaded and extracted the ObservelT
Installer.

Make sure to Run as administrator.

Navigate to ObservelT_Setupv.xx > Screenshots Storage Optimizer folder and click Screen-
shotsStorageOptimizer installer. Follow the Wizard. When prompted to provide the configuration,
make sure to use the file saved in Step 6

Screenshot Storage Optimizer Wizard

1.

Open the wizard using manual or automatic installation.

observel

a proofpolnt cormpany

The installer will guide you through the steps required to install Screenshots Storage Optimizer on
your compriter.

Click "Next" to continue.

WARNING: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, map result in severe civil
of criminal penalties, and will be prosecuted to the maxamum extent possible under the law.

Click Next.
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The Screenshots Storage Optimizer module will be installed to the below folder,

Click Next to install it in the below folder or Browse to choose a different folder.

Eolder:
[E: \Program Files\Observel T\Screenshots Storage Optimizer, Browse...

Installation configuration file:

[Ellck Browse o type the configuration file full path Browse...

The installation configuration file can be downloaded by the
admin user from ObservelT Web Console, from the Service
Settings screen in the Configuration area.

Cancel < Back

3. Installin the default folder or browse to the folder you want. Click Next.
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Please fill in the required \Windows Authentication details

Authentication method: (®) System Authentication

(O Windows Authentication

Cancel < Back Newt >

4. Select the authentication method. Click Next.
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Enter Apphcation Server and Web Console location

Type: Application Server Name/IP address Pout:
hitp v [localhost [4834
Type: ‘Web Console Server Name/IP address Pout:
[htp v|  [locaiost [484
Test Connection
Cancel ¢ Back Ne

5. Enter the locations. Click Test Connection.
6. Ifthetestis successful, click Next. The installation starts.

7. When complete, click Close.

When the Wizard is done, continue with Advanced Web Console Setup.

INSTALLING THE WEBSITE CATEGORIZATION MODULE

The Observel T Website Categorization module automatically detects categories of Websites that end
users are browsing, enabling alerts to be generated on browsing categories such as Gaming, Adults, Infec-
ted or Malicious Websites, Phishing Websites, and more.

The diagram below shows the configuration including the Web Categorization module.

Application Levver Wie Lerver
Winciows Sorver » It

= o

41 Server

e
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WEBSITE CATEGORIZATION PREREQUISITES

In order to trigger alerts on Internet browsing, the Website Categorization module must be installed. The
Website Categorization module can be installed on the same machine as the Web Console or on a sep-
arate dedicated machine (recommended).

Prerequisites for installing the Website Categorization module

To download the initial data and receive updates directly from NetSTAR cloud service, your
machine (that is, the server on which the Website Categorization module is installed), you must
have Internet access.

If you don’t have Internet access you can use an HTTP proxy that will provide Internet
access and allow the data download.

Make sure that port number 443 is open, and that the URL https://nsv10.netstar-inc.-
com/gcfus/get.cgi (that the module needs to access NETSTAR for initial data download and daily
database updates) is not blocked by the Firewall.

Make sure that the URL https://nsv10.netstar-inc.com/gcfus/get.cgi and http://dss.netstar-inc.-
com/ (that the module needs to access NETSTAR for initial data download and daily database
updates) are not blocked by the Firewall.

12 GB minimum memory requirement. If you install the Website Categorization module on a
machine with less than 12 GB RAM, the first time that the module detects the categorized browsed
URLs, alerts will not be generated. Upon subsequent browsing, alerts will be generated on these
URLs.

Open port 8000 between the Application server and the Website Categorization.

Installing the Website Categorization Module

The following procedures describe the steps required to install the Website Categorization module for a
Custom installation and One-Click Installation. The module can be installed on a separate dedicated
machine or executed from the One-Click installation.

Custom installation installs the Website Categorization module via a separate installation file.

System events related to installation of the Website Categorization module and download of the
web categories database are generated by the system. For details, see Event Types.

Installing the module using a Custom installation

1. Onthe ObservelT Application Server, open Windows Explorer and browse to the ObservelT Install-

ation folder.
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2.

Open the WebsiteCat folder and double-click the WebsiteCat_Setup Installer package.

=
°k)v| . = Computer = Local Disk {Ci) = ObservelT_Setup_v6.7.0.194 - WebsiteCat

Organize ¥ ﬁllnstall ¥  New folder

7 Favorites Mame « Date modified Type Size

B Desktap WebsiteCat_Setup 8/31/2016 5:00 AM “Windows Batch File 1KB
& Downloads -

016 5:10 AM ‘windows Installer P...

= Recent Places

The installation process searches for the installed ObservelT SQL Server database. The following
message is displayed:

Gathering information for installing the Website Categorization module.
Please wait...

If after gathering information, the ObservelT database was not found, the following message is dis-
played:

SQL Server with ObservelT databases was not found.

Please install ObservelT databases before running the installation of the Website Categorization
module.

The installation checks whether the module is already installed on this machine; if it is, you can
repair or remove it.

If the module is not already installed, the Website Categorization Installation wizard opens, dis-
playing the following information.
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B Website Categorization Installation = =

observeIr

4 procfpoint. company

“webzite Categorizabion module detects automatically the categony of websites browsed by
emplovees. 11 allows getbng alests upon browsng to specific categaties such as Gamng, Sduls,
InfectadsMalcious websites, Phrishing websbes and morea.

Plzase mabe that this madule requires Intemel access fol the inilial dowrload of the calegoeization
daba and for getting daiky updates. The conneciidly b the updabe zervice wil be bested [dizplapng a
successfalune indication] during thiz inztalation process.

Far optimal perfaimance, # is recomamended to instal thiz module on a s2palate maching, snd not on
amachine on which other Obzervel T modules have been instaled

Foi aptimal perloimance, # iz &lwo iecommended o nstall this module on a machine with al keasl
SGE memary [RAM).
This machine is equipped withe 8067 MB of RAM

Cancal Back | Mgt

3. To continue, click Next.
The default installation folder is displayed. If you want to change the default installation folder,
clickthe Browse button and select the required folder.

1) Website Categorization Installztion = =

observeITr

o proofpoint company

The Ysfebsite Categonzalion madule wil be instaled 1o the below lalder

Click Mext ta instal it in the below folder o Browse to choose a diiferent folder,

Ealdear:
|E:\Fmgra'n FiteshObeareal TWW ebeibeCath Broves... ]

Carzal < Back Mext > ]
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4.

Click Next.

5. Select the SQL Server with which the module will interact (the drop-down list includes SQL Servers

which are already installed).
't"-) WebsitaCat = b

observeIr

& proofpolnt. company

Pleasa fil in the requied SOL Server detailz.
= :
Autherticaton method @ Inztaller Authentication [Obssrvel TUzer)
‘Windows Authenticabon
[ Cancel < Back Mext >
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6. Click Test Connection to check the status of connectivity to the server.
i Website Categorization Installation ==

observeIr
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Connection Test

The update service was accessed successiully.

Exit Installation Install Websie Categorization

Carceal < Back Mext >

7. Click Install Website Categorization to install the module (regardless of success or failure of the con-
nectivity test).
-Or-

Click Exit Installation to abort the installation.

Upon successful installation of the module, the last screen of the wizard displays:

80



observeir

a division of Proofpoint

i Website Categorization Installation [- =]
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‘WebsitalCat has been nstaled succasshdk.
Click "Cloze" lo et

DOpen wWindows Inztaller log

Cancel < Back Cloze

8. Click Close to exit the installation wizard.

Installing the module using a One-Click installation

1. Run thethe Setup.exe Installer file from the ObservelT installation folder.
The ObservelT main installation screen opens, in which you can configure the settings for SQL

Server, Web Console (which includes also the Application Server), License, and Installation Log and

Progress. For details, see ObservelT One-Click Installation.
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#3 Observell Installer &
a proofpoint company
SOL Server
i.e, Mocalhost” or "WACHINE, 14347
Server [iocar)] -]
Authentication & \Windows 7 SOL Server
User |
Password |
el sale
Website |CII:|ser'-'elT Application (port 4884) j ¥ Securs (HTTPS)
License
* Full Inztallztion ™ Upgrade Dbtain Trigl License
Inzsert license | Browse for License
Installation Log and Prograss
Currenl
Tetal Sherw Log
Terms of Service [ | Agree Support Instal Exit

2. Click Install to begin the installation.
Awindow opens, displaying information about the Website Categorization Installation, including

the volume of installed memory available on the machine on which the module will be installed.
Note that 12 GB is the minimum recommended memory requirement.
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i Website Categorization Installation L= | & |13
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‘wiebsile Calegorization module detects automaticaly the category of websikes bravws=d by
emplopees. It adllows gelbtng alests upon browsng bo specihic calegoies such a: Gaming, Aduls,
Infiected/ M abiows: webstes, Phishing webstes and more.

Fleass note that this madule iequires Inlemel access for the nilisl download of the categonzalion
data and lor getling daily updates. The conneciraly to the updabe service il be tested [duplasing a
succezsdfailune ndicabion] during thiz installaion process

Fir aplinal pesformance, it is recommendad o inst &l iz module on & sepatale maching, and not on
a machne on whach other Observel T modules have been nstalled.

For aplimal peformance, it iz alzo recommended bo inztzll this module on 2 mackine with a1 leas
BEBR memony [FAML

This machire i equipped withe 4092 MB of RAM

Carcal Bac Hext > |

3. Click Next to continue.
Upon successful installation of the module, the last page of the One-Click installation wizard shows
a summary of the installed components, including ObservelT - Website Categorization:
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# ObservelT Installer Ead

obser veIr

POt poir

Installation Completed Successtully

Se CbsarvelT Installation Camplatad
The following comgonents have been successfully
Au insiglled en this machine:

Uz ObservelT - Database

ObservalT - Application Sanver

Fal  ObservelT - Web Consale
ObaervalT - Webaite Categorization

ObservelT - Agent

Wy Ta begin using ObservelT, open the \Web Console from the Start

We menu, or by clicking hege. BS)
Flease Mote:

The default usermame is "admin”

) benss
y 14 days free support . F_
In ot Eree cunnart (EES) Ense
= ! I"\:_-'f" N

N Cloge

In=;

] |

Installation Completed [ step 7 of 7) Show Log

Terms of Service [# | Agres Suppart Install . Exit

4. Click Close to exit the installation.

Installing the module using PowerShell
Open PowerShell as administrator and paste the following commands to execute automatically.

The below command assumes the ObservelT installer is located under the C: \Temp\ObserveIT-
Setup v7.8.2.270 path. Replace the location with the location of ObservelT installer you are using.

After the execution of below command, the installation Wizard opens.

Start-Process msiexec -ArgumentList '/i', "C:\Temp\ObserveIT-NL
Setup v7.8.2.270\WebsiteCat\Websitecat Setup.msi", '/norestart',
/1%y ObservelITWebConsole setup.txt'

Related Topics:
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CONFIGURING INTERNET PROXY SETTINGS FOR WEBSITE CATEGORIZATION
MODULE

This section describes configuration of the Internet proxy for the Website Categorization module, allow-
ing the Website Categorization module component to access the Internet and automatically update the
internal website list.

Webs

ite Categorization module does not support proxy authentication.

10.
11.

12.

13.

Connect to the Observel T Website Categorization module machine.
Open the Start menu and type Run. Enter.

Right-click the Notepad shortcut icon and click Run as administrator.

If porompted Do you want to allow this app to make changes to your device?, click Yes. Select File
>Open.

Navigate to the following folder: C: \Program Files\Ob-
servelT\WebsiteCat\Adapters\NetStar\db\etc)\.

In Notepad, change the file type from Text Documents (*.txt) to All Files (*.*).
Locate the gcfl.conffile, click it, and click Open.

In the # Proxy Settings section, locate the PROXY_HOST=string. Enter the IP address or the FQDN
of the proxy server after the = sign.

Locate the PROXY_PORT=string. Enter the port of the HTTP or HTTPS proxy after the = sign.
From the File menu, select Save.

Close Notepad.
Open the Start menu and typePowerShell..

If porompted Do you want to allow this app to make changes to your device?, click Yes. Select File
>Open.
Paste the following command into the PowerShell window and press the Enter key:

Get-Service WebsiteCat.Manager,GCFlService | Restart-Service -
Force

&"C:\Program Files\ObserveIT\WebsiteCat\WebsiteCat.Manager.exe"
-dw
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14.

It is safe to close the PowerShell window now. A download window may appear. Do not close the
new window until the operation is complete.

VERIFYING THE OBSERVEIT SERVICES IDENTITY

The ObservelT installation creates four services. When running the ObservelT installer as the ObservelT
Service Account, the services will be automatically configured to use the ObservelT Service Account iden-

tity.

On the ObservelT Application Server machine(s) the following service is present:

ObservelT Activity Alerts Service

On the Web Console machine, the following services are present:

ObservelTNotificationService
ObservelT Health Monitoring Service
ObservelT Analytics Service
Screenshots Storage Optimizer
GCF1Service

WebsiteCat.Manager

Verifying the ObservelT Alerts Services Identity (Manual)

1.

2.

10.

Connect to the ObservelT Application Server machine.
Open the Start menu and type Run. Enter.

Type services.msc. Enter.

Find the ObservelT Activity Alerts Service in the list.

Verify the Log On As column reflects the ObservelT Service Account identity. If it does not, follow
the rest of this procedure. Otherwise, verify the ObservelT Service Account identity for other
ObservelT services.

Right-click the service and click Properties.

Click the Log On tab.

Select This account. Click Browse.

Click Locations and ensure your Active Directory domain is selected.

In the Enter the object name to select field, type OITServiceAccount. Click OK.
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11. Inthe Password and Confirm password fields enter the password for the ObservelT Service
Account user.

12. Click OK. If a message pops up that the user OITServiceAccount has been granted the Logon as a
service rights, click OK.

13. Right-click the ObservelT Activity Alerts Service and click Restart.

14. Perform steps 5-12 on the remaining 3 ObservelT services — 4 total —named ObservelT Health Mon-
itoring Service, ObservelT Notification Service and ObservelT User Analytics Service.

Verifying the ObservelT Alerts Services Identity (Powershell - Automatic)

Open PowerShell as administrator and paste the following commands to execute above steps auto-
matically. After the execution of below command, you will be prompted to supply the ObservelT Service
Account credentials. Enter the credentials and press the OK key to continue. All the ObservelT com-
ponents will be configured to use the new credentials.

function Set-OITAccount ($Credentials) {
if ('$Credentials) ({

$Credentials = Get-Credential

}

$UserName = S$Credentials.GetNetworkCredential () .Domain + '\' +
$Credentials.GetNetworkCredential () .UserName

$Password = $Credentials.GetNetworkCredential () .Password

$0ITServices = Get-Service observeit*, screenshot*, websitecat*,
gcflx*

foreach ($Service in $0ITServices) ({

$Service = $Service.Name

Write-Output "Working service $Service"

$svc_Obj = Get-WmiObject Win32 Service -filter "name='S$service'"
$ChangeStatus = $svc_Obj.change($null, $null, $null, $null, $null,
$null, $UserName, $Password, $null, S$null, $null)

If ($ChangeStatus.ReturnValue -eq "0")

{Write-host "User Name sucessfully for the service '$Service'"}
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If ($ChangeStatus.ReturnValue -eq "0")

{Write-host "The service '$Service' Started successfully"}

}

foreach ($service in $0ITServices) ({

Get-Service $Service.Name | Restart-Service

}

Write-Output "Setting credentials for the ObservelIT Application Pool"
Import-Module WebAdministration

Get-Item IIS:\AppPools\ObserveIT* | Set-ItemProperty -name
processModel -value @{userName = "$UserName"; password = "$Password";
identitytype = 3}

Start-Process iisreset -NoNewWindow

}

Set-OITAccount

Configuring ObservelT Installation

To configure ObservelT installation, complete the following tasks.

e Configuring Your Admin Password

e Obtaining a Commercial License

* Configuring LDAP Settings

e Configuring SMTPSettings

e Configuring Screenshot Data Storage

CONFIGURING THE ADMIN PASSWORD

The first time you access the ObservelT Web Console, you are prompted to configure the password for
the default ObservelT Admin user account.
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1. Open your preferred Web browser. In the address bar type the URL address of your ObservelT
Web Console in the format:

https://<WebConsoleServerAddressFQDN>/ObservelT
For example:

https://oitsrvl.oit-demo.local/Observel T

2. The browser window opens and you are prompted to set the password for the admin user.

observeir
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3. Inthe Password and Confirm Password fields enter the password for the ObservelT Admin user
account.

4. ClickLogIn. Your password is now set.

CONFIGURING LDAP SETTINGS

In a Custom Installation, you must manually configure the LDAP connector settings.

The LDAP connector enables usage of Active Directory-based users and groups for various system set-
tings, such as:

e Using Active Directory with Console groups

e |ntegrating Active Directory users with Secondary Authentication
e Filtering Active Directory groups by Secondary Authentication

e Displaying logon messages to specific Active Directory users

89



observeir

a division of Proofpoint

e Recording/no recording Active Directory users and groups
* Integrating DNS for Agent auto-configuration
e Using Active Directory users when detecting Identity Theft

1. From the the ObservelT Web Console, select Management Console. Then select Configuration>
LDAP Settings.

2. From the LDAP Settings tab, in the Automatic LDAP Target area, select Detect Domain
Membership.

— Automatic LDAP Target

Mote: Clicking the "Detect Domain Controller” button will first detect whether the ObservelT Application Server
belongs to an Active Directory domain. Iftrue, an automatic-type LDAP path will be added to the LDAF list below.
Only automatic-type ("Auta™) domains can be used for Active Directory Groups.

Detect Domain Membership | | Synchronize LDAP Groups

)

If the Domain path and credentials are valid, the connection will be added to the LDAP Target List.
The LDAP Target type will be set to Auto.

LDAP Targets List

LDAF Path Domain Name User Name Alias  Type Created Date

LDAP/DC=0IT-DEMO DC=LOCAL OIT-DEMO.LOCAL Auto 44f2014  Delete

The Detect Domain Membership button is grayed out and cannot be used again, because
the endpoint can be a member of only one domain.

CONFIGURING SMTP SETTINGS

If you would like to receive email notifications from your ObservelT installation, such as notifications,
reports and alerts, configure SMTP settings.

The Web Console is responsible for sending emails from ObservelT. Allow the Web Console to send email
via your email server.

1. Loginto the ObservelT Web Console.

2. Select Management Console at the top of the screen, select Configuration > SMTP Settings.
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SMTP Settings

SMTP Settings

SMTP Server 192.163.100.1 Port |25
Mail From support@mail.com

User Name Iadmin

password [

Please enter a valid email address for the settings verification message.

Email Address

In the SMTP Server field, enter the FQDN of your email server. Adjust the Port field value if neces-
sary.

In the Mail From field, enter the email address which will identify the sender of ObservelT noti-
fications.

Optional: In the User Name and Password fields enter credentials for the account authorized to
send emails using the specified email server.

Click Update to save the details.

To verify ObservelT can successfully send emails, enter a working email address in the Email
Address field and click Send.

If the verification is successful, a Successfully Verified message appears and you should receive an
email from an email address specified in the Mail From field.

CONFIGURING SCREEN CAPTURE DATA STORAGE

Screen capture data takes up more storage space than metadata and is configured separately.

For most deployments, it is essential to store the screenshot data directly on a file system (such as NTFS).

This procedure describes how to move the default storage location to the file system.
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1. From the ObservelT Web Console, navigate to Configuration > Storage.

2. Select the Screen Capture Data tab.

R R

Screen Capture Data Storage

Screen capture data can be stored in 3 different modes:
1. Within SOL Server
2. In the file system on a single standard storage
3. In the file system on both a fast S50 storage (named Hot Storage) and on a standard storage (named Warm Storage) to achieve faster archiving process.

Screen capture data is curren|ity stored in: SOL Server Change storage mode

rSOL Server Storage Properties
Database server: WIN-TSPUCHAZEHR
Database name: ObsarvelT_Data
Database path: chprogram files\micresoft sgl serverymssqll 3 mssqlserverymssqhdata\ObservelT_Data_Data.mdf
Date range of included sessions: 10/13/2017 10:36 P - 1/29/2018 337 PM
Current screen capture storage: 1.27 GB (30605 Shides)

3. Select Change storage mode. When prompted about changes, click Yes.

Storage Mode B

How do you want screen capture data to be stored?

Within SQL Server DB

Only on a single standard hard drive

Archive path: | \ObservelT_Archive_1

® On fast S5D-based hard drive (Hot Storage) for live sessions, and then signed sessions on standard hard drive (Warm Storage).

Hot Storage path: Test Access

‘Warm Storage path: Test Access

Archive path: \ObservelT_Archive_1

) Trigger System Event when the Hot Storage reaches a capacity of|  80% out of the allocated GB

Please note: It's highly recommended to check this option and configure email notification for it (in System Events screen)

Save Changes Cancel

4. Select On fast SSD-based hard drive (Hot Storage) for live sessions, and then signed sessions on
standard hard drive (Warm Storage).

5. Specify the Hot Storage path, the Warm Storage path, and the Archive path.

92




observeir

a division of Proofpoint

6. Click Test Access for each path to verify ObservelT can successfully access each path.

7. Click Save Changes.

Configuring Traffic Security

This topic describes how to encrypt data in transit.

By default, ObservelT Agents communicate with the ObservelT Application Server by using the HTTP pro-
tocol.

As a built-in security mechanism, the ObservelT Agents and Application Server use a token exchange
mechanism to prevent session hijacking and replay, and to encrypt the data communication. The security
mechanisms for this communication include encryption (Rijndael), digital signing, and token exchange.

Encryption can be enabled to further secure the communications:
e Between the Agents and the Application Server (HTTPS)
e Between the Application Server and the Database Server (HTTPS)

e Between the Application Server and the file share holding the graphic images (IPsec)

If you are deploying more than one Application Server, you must use a network load balancing
product. This can be a software-based load balancing solution such as Microsoft Network Load
Balancing (NLB), or hardware-based solutions such as F5, Citrix NetScaler, or others. In that case,
the digital certificate used for this traffic must be identical for all Application Servers, which can be
achieved by creating it on the first Application Server, exporting it (including the private key), and
importing it to the other Application Servers.

REQUIREMENTS

HTTPS can be used on the ObservelT website (either optional or mandatory) to protect the data trans-
ferred by the Agents to the ObservelT Application Server.

If you plan to deploy more than one Application Server, you must use a network load balancing product.
This can be a software-based load balancing solution such as Microsoft Network Load Balancing (NLB), or
hardware-based solutions such as F5, Citrix NetScaler, or others. In that case, the digital certificate used
for this traffic must be identical for all Application Servers, which can be achieved by creating it on the first
Application Server, exporting it (including the private key), and importing it to the other Application Serv-
ers.

Required steps to enable traffic encryption between the ObservelT Agents and the Application Server:

93



observeir

a division of Proofpoint

Obtain a digital certificate.

Encrypt the traffic from ObservelT Agents to ObservelT Application Server.
Configure ObservelT Agent for Windows to use SSL.

Configure the ObservelT Agent for Mac to use SSL.

Configure the ObservelT Agent for Unix/Linux to use SSL.

CONFIGURING OBSERVEIT APPLICATION SERVER FOR DATA TRANSIT
ENCRYPTION

To configure ObservelT Application server for data in transit encryption, you need to set the protocol to
HTTPS, not HTTP. In addition, you need SSL certification.

1. Connect to the ObservelT Web Console machine and if you need, request or create a digital cer-

9.

10.

tificate.

From the Start menu and type Run. Enter.

Type IIS, select the Internet Information Services (11S) Manager. Enter.
From the menus, expand Sites.

Right-click the Observel TApplication website, and select Edit Bindings.
Click Add.

Change the value in the Type field from http to https.

Make sure the value for Port field is set at 443.

Under SSL certificate select the certificate you have created or acquired.

Click OK to create the bindings. Click Close to close the window.

When enabling HTTPS encryption on an existing ObservelT installation, with existing ObservelT
Agents, remember that removing an existing, non-encrypted binding, will cause existing
ObservelT Agents to cease communications with the ObservelT Application Server. It is recom-
mended to leave as-is the previous, non-encrypted binding at this point.

CONFIGURING WINDOWS AGENTS TO USE SSL

After configuring the Observel T Application Server to require usage of HTTPS, configure the ObservelT

Agent to use HTTPS when communicating with the ObservelT Application Server.
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New ObservelT Agent Deployment

When configuring HTTPS during deployment of new Agents, remember the following:

During the ObservelT Agent deployment, in the Enter Application Server Location screen, set the
value for Type field to https. Specify the server's FQDN in the Server Name field.

If a non-default HTTPS port is used, specify it in the Port field.

If using self-signed certificates, ensure the certificates are trusted by both parties. You can skip this
step if certificates from Enterprise Certificate Authority are used.

If a firewall is enabled on the ObservelT Application Server, ensure the correct incoming port is
allowed in the firewall settings.

Existing ObservelT Agent Deployment

In existing ObservelT Agent deployments, when configuring HTTPS traffic between the ObservelT Applic-
ation Server and ObservelT Agents, you must make changes in the ObservelT Database, which will propag-
ate to the existing Observel T Agents, and will configure them to use SSL when communicating with the
ObservelT Application Server.

To make changes to the ObservelT Database for enabling HTTPS on the Agents:

1.

2.

Connect to the SQL server or to a computer with SQL Management Studio installed.
Open SQL Management Studio.
Type the SQL server's FQDN or IP address into the Server name field.

Select Windows Authentication if your account has sysadmin permissions on the SQL server.
Otherwise, select SQL Server Authentication and log in with a sysadmin-level account.

Click OK to connect.
From the File menu, click New and Query with Current Connection.

To Check the current connection URL, copy and paste the following code into the Query window:
Use ObservelT

select * from dbo.ServerConfiguration

WHERE PropertyId = 4

Click Execute to run the query.

Paste the following code into the query window, where NEW_APP_SERVER_URL is the new
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10.

address, with the HTTPS connectivity specified, and OLD_APP_SERVER_URL is the address currently
in use.

Use ObservelIT

UPDATE dbo.ServerConfiguration

SET PropertyValue = '<NEW APP SERVER URL>'
WHERE PropertyId = 4

AND PropertyValue = '<OLD APP SERVER URL>'
For example:

Use ObservelIT

UPDATE dbo.ServerConfiguration

SET PropertyValue = 'https://oitsrvl.oit-
demo.local:10443/0ObservelITApplication’

WHERE PropertyId = 4

AND PropertyValue = 'http://oit-srvl.oit-
demo.local:4884/0ObservelTApplication’

Click Execute to run the query

CONFIGURING A MAC AGENT TO USE SSL

This procedure describes how to install a trusted internal CA certificate on a Mac.

OBTAINING AND IMPORTING A CERTIFICATE

If you do not already have a trusted internal CA certificate, perform the following procedure to obtain
and import the certificate.

To obtain and import certificates
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1. Goto Start>run and enterinetmgr.

File View Help

Q-2 18 e ObservelT Application Home B bu
ore
9 ﬁ;m’ﬁ ST administaton) Filter: - ¥ Go - (FShowAll | Groupby: Ares - [E- Edit Perrnizsion=-J
< e Edit Site
2 Application Pools AP.NET " Bindi
<8 stes & . B © s
14D Default Web Site ) = @ ? J’rEE' \5\/’”) =N | [ Besic Settings..
4 Q Observel T &Eication WMET JNET JMET Error MET (MET Profile  .MET Roles  JMET Trust  JMET Users View Applications
I~ aspnet_client Authorizat.. Compilation Pages  Globalization Levels View Virbual Directories
P;? ObsenvelT (@ - K [ —— |
|- ObservelTapplicationSenver Lgﬁ: | =5 L & Manage Website
Application Connection MachineKey Pagesand  Providers Session State SMTP E-mail & Restart
Settings Strings Controls P Start
[ || ® stop

2. Goto ObservelT Application, and select Bindings.

In the Site Bindings dialog box, select the https protocol and click Edit.

4. Inthe Edit Site Bindings dialog box, click View.

In the Certificate dialog box, select the Certification Path tab, select the root CA certificate, and
click View Certificate.

General I Details | Certificabon Path

Certification path

tsta-SERVER 1-CA
53] tsta-CA-SRV1
i-{55] tsta-CA-SRVI-CA
] sue1ow12-2.15ta local

Certificate status:
is certificate is OK.
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6. Select the certificate's Details tab, and click Copy to File.

Field Value ~
[ version V3 ]
[ serisl rnumber 460D TecBII Db, |=
- Signature algorithm sha 1854
|~ Signature hash akgorithm shal =
JE=TS ma-ﬁ‘-ﬂlﬂ;lsla;bcal
Walid from Thursday, January 22, 2015 L.,
[valid 10 Wednesday, Jaruaty 22, 202...
[ suibject teta-SERVERL-CA, teta, local | v
| EditProperties... | | cCopytoFie.. |

[oc ]

7. Inthe Certificate Export Wizard that opens, click Next.

8. Select the Base-64 encoded X.509 (.CER) format option, and click Next.

Expart File Format
Certificates can be exported ina vanety of file formats,

Select the format you want to use;
() DER encoded binary X.509 {.CER)
(%) Base 54 encoded X. 509 (.CER)

() Cryptographic Message Synitax Stendard - FKCS 27 Certificates (F78)
[ |indude all certificates in the certification path f possible

() Personal Information Exchange - PKCS 212 [ PFX)
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9. Click Browse, and specify the name of the file to which you want to export the certificate.

File to Export
Spedfy the name of the file you want to expaort

File name;

€:\sers\admiristrator TSTA\Desktop'certificate.cer | | eromse...

10. Click Next, and then click Finish to close the Certificate Export Wizard.

11. Inthe message box stating that the export was successful, click OK.

The export was successful.

COPY THE CERTIFICATE TO YOUR MAC

1. Copythe Certificate to your Mac target server.

2. Select Keychain Access ﬁ .

The list of certificates displays. A red X indicates that the certificate is not trusted, for example,
tsta-SERVERI-CA in the list below.



observeir

a division of Proofpoint

. -SERVER1-CA
wta =

LT .

6 login o et et st autgeity

u Local flems | Dt Wednesday, 22 Janusry 2020 81 12:20:02 kareel Standard Time

ﬁ System O “teta-SLAVIRI-CA° contificate is not trusted

) System Roots

Hamae Karad Drabe e Topad Enpires Eeychaan
;L ety DirectoryWQBSERVIIT-5vE spoicaton paseword 13 Jun 2008 gt 104738 = Ftem
L] com.appie. cevierns oo certficate - @ Dec 2037 at 1ciEg Sysiem
T com.appie. kerteros i public key s . Sysiem
L] com appie wystemdetas certficate -- B B 20T at 1EIL0 Syslem
'i? OO BpEe. Sysiemaoed s publc bey - ve Sysiem
T comupois. matemastea Bivate gy = - Syitem
Category E CoservelT JE_ert¥cate Authority certficate = 26 Sep 2027 01 130 Syntem
A A eems
L. Pasawords
Secure Notes

Bl My Certificates

T ke

Lal Certificates

3. Select the certificate you want to make Trusted.

tate-SERVERY-CA

Aoot cetificals suthority

- Expires: Wednesday, 12 January D020 of 15T9:00 wraed Standard Tira
0 “tsia-SEAVER-CA® certificate s not irusted

¥ o lileante:

£

¥ Trest

Wihan usersg ihis certficate: | Ulse Sysbers Delsuis B ?

Sscure Sockets Layer (S5L) mo value speciied
Secuns Mail (S]] fo valve wpecified
Ixtamiible Authenticaticn [LAP) Mo valud EDoCTpd
1P Bacurity [IPSsE] Mo vl aDeolsd

Code Signimg  no valus specied

Tima Stamping o value specied

EB00 Dasic Policy  fd value petiied

¥ Dutails
Subject Hame
Doemnain Componant  local
Damiain Componant LN
Common Wams  tte-3EMERT-CA

4. Setthe Trust level according to your company's requirements. At a minimum, you must select
Always Trust for the When using this certificate option.

100



observeir

a division of Proofpoint

CONFIGURING A UNIX LINUX AGENT TO USE SSL

This procedure describes how to install a trusted internal CA certificate on a Unix/Linux server.

OBTAIN AND IMPORT A TRUSTED INTERNAL CA CERTIFICATE

If you do not already have a trusted internal CA certificate, perform the following procedure to obtain

and import the certificate.

To obtain and import certificates

1. Goto Start >run and enterinetmgr.

File View Help

Q-2 18 e ObservelT Application Home
:"35 ﬁ;;‘:‘::_z P —— Filter: - ¥ Go - (Fshewall | Groupby: Ares - E-
-3 Application Pocls ASP.MET
4 [@] Sites = & = = i %
b D Default Web Site ) = ;I 0 H05 2 .?f =
260 ObservelT Application MET MET MET Errar MET MET Profile  .MET Roles  .MET Trust  .MET Users
b aspnet_client Authonzat.. Compilation Pages Globalization Levels
b -(F Observell — y 3 == b, ?
1 F ObservelTApplicationServer g’: _j-b' [+ jTI |$ % =

Application Connection MachineKey Pagesand  Providers Session State SMTP E-mail
Settings Strings Controls

[

2. Go to ObservelT Application, and select Bindings.

3. IntheSite Bindings dialog box, select the https protocol and click Edit.

4. Inthe Edit Site Bindings dialog box, click View.

B Explore
Edit Permissions...
Edit Site
Bindings...

B Basic Settings...
View Applications
View Virtual Directories

Manage Website

& Restart
b Start

B Stop

5. Inthe Certificate dialog box, select the Certification Path tab, select the root CA certificate, and

101



observeIr

a division of Proofpoint

click View Certificate.

General | Details | Certificabon Path |

Cartification path

- [5] tsta-CASRY1
] tsta-CA-SRV-CA
] sUR 10w 122 ista Jocal

Certificate status:

e
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6. Select the certificate's Details tab and click Copy to File.

Field Value ~
[ version V3 ]
[ serisl rnumber 460D TecBII Db, |=
- Signature algorithm sha 1854
|~ Signature hash akgorithm shal =
JE=TS ma-ﬁ‘-ﬂlﬂ;lsla;bcal
Walid from Thursday, January 22, 2015 L.,
[valid 10 Wednesday, Jaruaty 22, 202...
[ suibject teta-SERVERL-CA, teta, local | v
| EditProperties... | | cCopytoFie.. |

[oc ]

7. Inthe Certificate Export Wizard that opens, click Next.

8. Select the Base-64 encoded X.509 (.CER) format option, and click Next.

Expart File Format
Certificates can be exported ina vanety of file formats,

Select the format you want to use;
() DER encoded binary X.509 {.CER)
(%) Base 54 encoded X. 509 (.CER)

() Cryptographic Message Synitax Stendard - FKCS 27 Certificates (F78)
[ |indude all certificates in the certification path f possible

() Personal Information Exchange - PKCS 212 [ PFX)
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9. Click Browse and specify the name of the file to which you want to export the certificate.

File to Export
Spedfy the name of the file you want to expaort

File name;
C1\sersladministrator. TSTA\Desktoppertficate. cer | | eromse...

10. Click Next and then click Finish to close the Certificate Export Wizard.

11. Inthe message box stating that the export was successful, click OK.

The export was successful.

COPY THE CERTIFICATES TO A LINUX SERVER

Prerequisite: See Locating the Certificates for information about verifying and locating a certificate and
how to locate the /certs directory.

1. You must transfer the exported certificates to the /certs directory of the appliance, using SCP/FTP
or any other protocol.

2. Ifyou are transferring the files using WinSCP, the file permissions might have changed. To verify
the file permissions, run the command: Is -la
The output should look like: -rw-r--r--.
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If the output looks different, change the file permissions so that "user", "group", and "other" will
have read permissions. Run the following command to make the changes: chmod w+r or chmod
O+,

To enable OpenSSL to identify the certificates, link them as follows

1. Extract the certificate's hash, and use it as a symbolic link to the certificate:
In -s certificate.pem 'openssl| x509 -in certificate.pem -noout -hash'.0

Or

In -s certificate.cer "openssl x509 -in certificate.cer -noout -hash".0

2. Verify the certificate installation by running the command:
openssl verify certificate.pem

openssl verify 3ee7e181.0

Configuring Simple Recovery Mode

Simple recovery mode is the recommended ObservelT database mode for a stand-alone, non-clustered
SQL server. Simple recovery mode may be configured manuallyor may be configured automatically via a

query

CONFIGURING SIMPLE RECOVERY MODEL FOR THE OBSERVEIT DATABASES ON
THE SQL SERVER

Arecovery model is a database property that controls how transactions are logged, whether the trans-
action log requires (and allows) backing up, and what kinds of restore operations are available. It auto-
matically reclaims log space to keep space requirements small, essentially eliminating the need to
manage the transaction log space.

If you need to use a point in time recovery option — use Full recovery model instead, which is the
default configuration option. No changes need to be made. For more information, see Full Data-
base Backups (SQL Server) MSDN article: https://msdn.microsoft.com/en-AU/lib-
rary/ms186289.aspx.

1. Connect to the SQL server or to a computer with SQL Server Management Studio installed.
2. Open SQL Server Management Studio.
3. Typeinthe SQL server's FQDN or IP address into the Server name field.

4. Choose Windows Authentication if your account has sysadmin permissions on the SQL server.
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Otherwise, choose SQL Server Authentication and log in with a sysadmin-level account.

5. Click Connect.

6. From the menus on the left, expand Databases.

7. Right-clickthe ObservelT database and select Properties.
8. From Select a page, select Options.

9. From Recovery model options. select Simple.

|| [N Database Properties - ObservelT - (m] b4
| Setect - =

ot Ssom - Mnek

& Fles

& Flegroups Collation: Latin1_General_CI_AS -
1 2 Options Wi .

3 Change Trackng Recavery model: w
& Permissions Compatilty lovel SO Server 2016 (130) v
_ME: Cortanment type: Hone w
2 Transaction Log Shipping Other options:

& Guery Store

s3]
~ Database Scoped Corfigurations ~
Legmey Cardinality Estimation OFF
Legacy Cardaliy Estimation For Secondary PRIMARY
Max DOP o
Max DOP For Secondary

Parmamatar Sniffing ON
Paramater Sriffing Fer Sacondary PRIMARY
Connection ‘Guary Optiizer Foens OFF
Sarver Query Optimizer Foces For Secondiary FPRIMARY
SUPTW2016 w FILESTREAM
Earnect FILESTREAM Dwnctory Name
SUPTW2015\ Adminksirabor FILESTREAM Mon-Transacied Access Off

Mizc
B+ View connection propedie - HwSenpting

Hde Fibm Settrigs
~  Miscellaneous

Meres Srapshat Isolation Falas
AMSINILILL Disdmsh Fordusn hs
MM Allow Snapshot Isolation
Cance
10. Click OK.

Repeat these steps for each ObservelT database.

CONFIGURING SIMPLE RECOVERY MODEL FOR THE OBSERVEIT DATABASES VIA
SQL QUERY

1. Connect to the SQL server or to a computer with SQL Server Management Studio installed.
2. Open SQL Server Management Studio.
3. Typeinthe SQL server's FQDN or IP address into the Server name field.

4. Choose Windows Authentication if your account has sysadmin permissions on the SQL server.
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Otherwise, choose SQL Server Authentication and log in with a sysadmin-level account.
5. Click Connect.
6. Select File > New > Query with Current Connection.

7. Paste the following code into the New query window:
USE master ;
ALTER DATABASE ObservelIT SET RECOVERY SIMPLE ;
ALTER DATABASE ObservelIT Analytics SET RECOVERY SIMPLE ;
ALTER DATABASE ObserveIT_Archive_l SET RECOVERY SIMPLE ;
ALTER DATABASE ObservelIT Archive Template SET RECOVERY SIMPLE ;

ALTER DATABASE ObservelIT Data SET RECOVERY SIMPLE ;

8. Click Execute to run the query.

Formatting NTFS

When using an NTFS volume for ObservelT image store, the drive containing the images may become frag-
mented and reach a limit where no further file operation will be available. To avoid this condition, format
the drive with support for large file size records.

1. Connect to the computer acting as the ObservelT file share.
2. Open the Start menu and type in COMPMGMT.MSC. Press the Enter.
3. Inthe Computer Management window, expand Storage, and click Disk Management.

4. Find the new diskin the list. Usually, it is the only one with the status Offline.
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10.
11.

12.

& Computer Management

File Action View Help

o a2 B = F

& Computer Management {Local
w [} Systern Tools
() Task Scheduler
B Event Viewer
gt| Shared Folders
& Local Users and Groups
() Performance
A Device Manager
v 58 Storage
Wy Windows Server Backup
™ Disk Management
T Senvaces snd Applications

Volurne Layout | Type | File Systemn | Status lc
- (] Simple Basic NTFS Healthy (Boot, Page File, Crash Dump, Primary Partition) &
== Systern Reserved Simple Basic NTFS Healthy (System, Active, Primary Pastition) 5

= Disk 0
Basic
45.00 GB
Online

O Disk 1
Basic

15.00 GB
line @)

0 Disk 2
Basie
1500 GB
Ofline )

System Reserved (=]
300 ME NTF5 44,51 GB NTFS
Healthy (System, Active, Prim | Healthy (Boot, Page File, Crash Dump, Primary Partitic

1500 GB
Unallocated

15,00 GB
Unallocated

W Unaliocated [l Primary partition

Right-click the disk and select Online.

Right-click the disk again and select Initialize Disk.

Click the GPT (GUID Partition Table) radio button and click OK.

Right-click the partition and select.

= Disk 1

Basic
1497 GB 1497 GB
Online Unallocated

Mew Simple Vhame_.

"0 Disk 2 I

Basic
1500 GB 15,00 GB
Offline () Unallocsted

Click Next.Make sure maximum the values specified in the Maximum disk space in MB and Simple
volume size in MB are equal. Click Next.

Assign an appropriate drive letter. Click Next.

Click the Format this volume with the following settings radio button and select NTFS.

Set the Allocation unit size:

e 4096 forimage storage.
e 64KB for SQL database.
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13.
14.
15.
16.
17.
18.

19.

20.
21.
22.
23.

24,

Assign an appropriate volume label at the Volume label field.

Make sure Perform a quick format checkbox is checked.

Click Next and review the settings. Click Finish.

Click the Start menu and type in RUN.

Type in CMD. Right-click the Command Prompt shortcut and click Run as administrator.
If porompted Do you want to allow this app to make changes to your device? click Yes.

Type in the following command:
format <driveletter>: /FS:NTFS /Q /X /L /A:4096

where <driveletter>is the letter of the volume you specified

If asked to specify current volume name, enter it and press Enter.

At the Proceed with format prompt type in Y and press Enter.

At the Volume label prompt enter a volume label, if required, and press Enter.
At this point the volume is formatted correctly.

Type EXIT and press Enter to exit the command prompt.

Using PowerShell

Windo

ws PowerShell is a command-line shell for system administrators. You can use it for many of the

installation procedures. It allows you to automate processes that might take more time manually.

To start PowerShell, from the Start menu, type powershell and Enter.

RUNNING ELEVATED WINDOWS POWERSHELL PROMPT AS A DIFFERENT USER

In situations when logging in interactively as the ObservelT Service Account is impossible, use the fol-

lowing
This wi

1.

procedure to start an elevated Windows PowerShell prompt as the ObservelT Service Account.

[l allow you to run ObservelT installers as the ObservelT Service Account.

In the PowerShell window, type in the following command, replacing Domain\Account with the
NETBIOS name of your Active Directory domain and the account name for the ObservelT Service
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Account:

Start-Process powershell.exe -Credential "DOMAIN\account" -
NoNewWindow -ArgumentList "Start-Process powershell.exe -Verb
runAs"

Enter.
In the Windows Security window enter the credentials of the ObservelT Service Account.
Click OK.

If prompted Do you want to allow this app to make changes to your device? click Yes.

A new elevated PowerShell window will start running as the ObservelT Service Account.
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